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1. About This Document

1.1 Version Information

Table 1 Document Versions

Document Code Date Description

M211095EN-H April 2017 Added 3 new commands for WS425 F/G ASOS protocol. Added
information about the new ASOS adapter.

M211095EN-G February 2017 Previous version

1.2 Documentation Conventions

alerts you to a fatal hazard. If you do not read and follow instructions
carefully at this point, death will follow.
DANGER!

alerts you to a serious hazard. If you do not read and follow instructions
carefully at this point, there is a risk of injury or even death.
WARNING!

warns you of a potential hazard. If you do not read and follow instructions
carefully at this point, the product could be damaged or important data could be lost.
CAUTION!

Note highlights important information on using the product.

Tip gives information for using the product more efficiently.
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1.3 Trademarks
Vaisalaâ and WINDCAPâ is a registered trademark of Vaisala Oyj. Windowsâ is a registered
trademark of Microsoft Corporation in the United States and/or other countries.

All other product or company names that may be mentioned in this publication are trade
names, trademarks, or registered trademarks of their respective owners.
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2. Product Overview

2.1 Introduction to WMT700
WMT700 measures wind speed and direction, and sends the measurement results to data
acquisition systems. WMT700 is suitable for systems and stand-alone installations.

The WMT700 series consists of four product types with different measurement ranges:
WMT701, WMT702, WMT703, and WMT704. You can select heating functions that shield the
array and/or the transducers and the sensor body from ice and snow build-up in cold
climates.

The WMT700 series wind sensors are based on the advanced, patented Vaisala WINDCAP
wind measurement technology that ensures accurate results in all wind directions. The
effects of temperature, humidity, and pressure are fully compensated.

Since the wind sensors have no moving parts, they are virtually maintenance-free. The
performance of the sensors does not degrade with wear nor is it affected by natural
contaminants such as salt, dust, or sand.

The WMT700 series wind sensors support a wide range of communication options. You can
connect the wind sensors directly to a variety of data acquisition systems without additional
converters or adapters.

WMT700 is configured at the factory according to your order, and it is ready for operation
directly after the installation. You also have a wide range of configuration options and
measurement settings.

WMT700 can be equipped with accessories to tailor the instrument to match different user-
specific needs. The accessories include a bird deterrent solution and a field-usable
calibration verifier.
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Figure 1 WMT700 Wind Sensor

The array consists of 1, 8, and 9.

1 Top of WMT700 with North arrow
2 Orange sticker marking North arm
3 Hot warning sticker
4 Type label
5 Mounting screw
6 Mounting adapter
7 Body
8 Transducer arms (3 pcs)
9 Transducers (3 pcs)
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Figure 2 WMT700 from Below

1 Mounting adapter screw (3 pcs; use 4-mm Allen key)
2 17-pin M23 male connector
3 Waterproof vent

Do not open the sensor. There are no user-serviceable parts inside.
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Figure 3 FIX70 Mounting Kit

1 Fix body
2 Removable mast guide with mounting hardware
3 Mounting hardware (M6 nuts, washers)
4 U bolts for Ø 30 mm mast (2 pcs)
5 U bolts for Ø 60 mm mast (2 pcs)
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Figure 4 WS425FIX60-POM

1 Clamp
2 Label

Figure 5 WMT700FIX60-POM

1 Clamp
2 Label
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Figure 6 WS425FIX60-RST and WS425FIX60

1 Label
2 Clamp

Figure 7  WMT700FIX60-RST

1 Label
2 Clamp
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2.2 Regulatory Compliances
Vaisala WINDCAP Ultrasonic Wind Sensor WMT701, WMT702, WMT703, and WMT704
comply with the performance and environmental test standards listed below.

Table 2 Environmental Tests

Test Setup According to

Wind driven rain MIL-STD 810G Method 506.5

Salt fog IEC 60068-2-52, VDA 621 - 415

Leak test (Ingression Protection) IEC 60529 class IP67

Vibration IEC 60068-2-6

Shock MIL-STD-202G, Method 213B, cond. J

Dry heat IEC 60068-2-2

Damp heat cyclic IEC 60068-2-30

Damp heat IEC 60068-2-78

Low temperature IEC 60068-2-1

Free fall (rough handling) IEC 60068-2-31

Change of temperature IEC 60068-2-14

Wind tunnel tests have been performed according to Sonic anemometers/thermometers -
Acceptance test methods for mean wind measurements ISO 16622:2002 and Measnet
Anemometer Calibration Procedure Version 2, October 2009.

EMC tests are based on a European product family standard: EN 61326-1:2013 (Electrical
equipment for measurement, control and laboratory use - EMC requirements for use in
industrial locations) and EN 60945:2002 (Maritime Navigation and Radiocommunication
Equipment and Systems - General Requirements - Methods of Testing and Required Test
Results).

Table 3 Electromagnetic Compatibility Tests

Test Setup According to

Conducted RF immunity IEC 61000-4-6

EFT immunity IEC 61000-4-4

Surge immunity IEC 61000-4-5

ESD immunity IEC 61000-4-2

High voltage (Dielectric tests) IEC 60947-2

Conducted emissions1) CISPR 22
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Test Setup According to

Radiated emissions CISPR 22

RF field immunity IEC 61000-4-3

Insulation resistance IEC 60092-504

1) Limits according to IEC 60945: Maritime navigation and radiocommunication equipment and systems - General requirements
- Methods of testing and required test results. 4th edition, 2002-08. See G. Certificate (page 199)

      

2.3 Ordering Options

Table 4 Ordering Options

Ordering Option
Number

Ordering Option

1 Measurement range

2 Temperature range

3 Heating

4 Digital communication interface

5 Digital communication profile

6 Digital communication unit

7 Analog output signal for wind speed channel

8 Analog output signal for wind direction channel

9 Connection cables

10 Mounting adapters

11 Not in use

12 Accessories

13 Manuals

If required, you can change:

• 2.3.4 Digital Communication Interface (page 20)
• 2.3.5 Digital Communication Profile (page 21)
• 2.3.6 Digital Communication Units (page 21)
• 2.3.7 Analog Output Signal for Wind Speed Channel (page 21)
• 2.3.8 Analog Output Signal for Wind Direction Channel (page 23)

WMT700 User Guide M211095EN-H

18



More Information

‣ Configuration (page 101)

2.3.1 Measurement Range
Ordering option 1 defines the wind speed operation range. The maximum reported value of
wind speed 40, 65, 75, or 90 m/s, depending on the selected option. Accredited Wind
Calibration according to Measnet procedure.

Table 5 Measurement Ranges of Different Sensor Types

Sensor Type Measurement Range

1 WMT701 up to 40 m/s

2 WMT702 up to 65 m/s

3 WMT703 up to 75 m/s

4 WMT704 up to 90 m/s

A WMT701 up to 40 m/s + Accredited Wind Calibration

B WMT702 up to 65 m/s + Accredited Wind Calibration

C WMT703 up to 75 m/s + Accredited Wind Calibration

D WMT704 up to 90 m/s + Accredited Wind Calibration

2.3.2 Temperature Range
Ordering option 2 defines the operating temperature range for the sensor.

Table 6 Temperature Range

Option Temperature Range

A -10 ... +60 °C

B -40 ... +60 °C

C -55 ... +70 °C

The temperature range is not connected to heating in any way. If you operate in a
demanding environment where ice accumulation is expected, Vaisala recommends using a
heated sensor.
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2.3.3 Heating
Ordering option 3 defines if the sensor is equipped with extra heating for demanding
environmental conditions. Option 4 providing full sensor heating is best suited for most
demanding environments.

Power consumption requirement depends on the selected heating option.

Table 7 Heating

Option Heating

1 Non-heated

2 Heated transducers (Min. 30 W power supply is needed)

3 Heated transducers and arms (Min. 150 W needed)

4 Heated transducers, arms, and body (Min. 250 W needed)

Vaisala recommends using heated versions of WMT700 in environmental conditions
where snow and ice build-up is possible.

2.3.4 Digital Communication Interface
Ordering option 4 defines the serial line physical interface. Four different standard
communication interfaces are available. In addition, there is a service port.

Table 8 Digital Communication Interface

Option Hardware Interface

A RS-485 isolated (1 pair)

B RS-422 isolated

C RS-232 isolated

D SDI-12 isolated

To change the product version characteristics listed in Table 8 (page 20), contact Vaisala
Service Center.
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2.3.5 Digital Communication Profile
Ordering option 5 defines the used communication protocol. WS425 options are usable and
backwards compatible when replacing a WS425 sensor with a WMT700 unit. Other
application or customer-specific user profiles are also available.

Table 9 Digital Communication Profile

Option Communication Profile

0 WMT70 - default mode 9600, 8, N, 1 Polled

1 WS425 - ASCII 2400, 8, N, 1 Polled

2 WS425 - NMEA Extended (v
0183)

9600, 8, N, 1 Auto send 1/s

3 WS425 - SDI-12 (v 1.3) 1200, 7, E, 1 Polled

4 WS425 - ASOS 2400, 8, N, 1 Polled

5 ROSA - MES12 9600, 8, N, 1 Polled

8 AWS520 - NMEA Extended (v
0183)

4800, 8, N, 1 Auto send 1/s

A MARINE1 (v 0183) 4800, 8, N, 1 Auto send 1/s

2.3.6 Digital Communication Units
Ordering option 6 offers four different digital communication options.

Table 10 Digital Communication Units

Option Unit Used

A Meters per second

B Knots

C Miles per hour

D Kilometers per hour

2.3.7 Analog Output Signal for Wind Speed Channel
Ordering option 7 can be disabled or factory-configured for 8 different modes. WS425
options are usable and backwards compatible when replacing WS425 sensor with a
WMT700 unit.
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Table 11 Output Configuration

Option Output Configuration

0 Disabled

1 Voltage output 100 mV/m/s

0 mV = 0 m/s

4000 mV = 40 m/s (WMT701 maximum wind speed)

6500 mV = 65 m/s (WMT702 maximum wind speed)

7500 mV = 75 m/s (WMT703 maximum wind speed)

9000 mV = 90 m/s (WMT704 maximum wind speed)

3 Current output 4 … 20 mA, offset 4 mA

4 mA = 0 m/s

20 mA = 40 m/s (WMT701, 0.4 mA/m/s)

20 mA = 65 m/s (WMT702, 0.24615 mA/m/s)

20 mA = 75 m/s (WMT703, 0.21333 mA/m/s)

20 mA = 90 m/s (WMT704, 0.177778 mA/m/s)

Error indication sets output to 2 mA

4 Current output 0.2 mA/m/s

0 mA = 0 m/s

8 mA = 40 m/s (WMT701 maximum wind speed)

13 mA = 65 m/s (WMT702 maximum wind speed)

15 mA = 75 m/s (WMT703 maximum wind speed)

18 mA = 90 m/s (WMT704 maximum wind speed)

6 Frequency output 10 Hz/m/s

0 Hz = 0 m/s

400 Hz = 40 m/s (WMT701 maximum wind speed)

650 Hz = 65 m/s (WMT702 maximum wind speed)

750 Hz = 75 m/s (WMT703 maximum wind speed)

900 Hz = 90 m/s (WMT704 maximum wind speed)

7 WS425 voltage output 8 mV/mph

0 mV = 0 m/s

716 mV = 89.5 mph (WMT701 maximum wind speed)

1116 mV = 145 mph (WMT702 maximum wind speed)

1344 mV = 168 mph (WMT703 maximum wind speed)

1610.4 mV = 201.3 mph (WMT704 maximum wind speed)
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Option Output Configuration

8 WS425 frequency output 5 Hz/mph

0 Hz = 0 m/s

447.5 Hz = 89.5 mph (WMT701 maximum wind speed)

725 Hz = 145 mph (WMT702 maximum wind speed)

840 Hz = 168 mph (WMT703 maximum wind speed)

1006.5 Hz = 201.3 mph ( WMT704 maximum wind speed)

A Push up output, 10 Hz/m/s

0 Hz = 0 m/s

400 Hz = 40 m/s (WMT701 maximum wind speed)

650 Hz = 65 m/s (WMT702 maximum wind speed)

750 Hz = 75 m/s (WMT703 maximum wind speed)

900 Hz = 90 m/s (WMT704 maximum wind speed)

B Pull down output 10 Hz/m/s

0 Hz = 0 m/s

400 Hz = 40 m/s (WMT701 maximum wind speed)

650 Hz = 65 m/s (WMT702 maximum wind speed)

750 Hz = 75 m/s (WMT703 maximum wind speed)

900 Hz = 90 m/s (WMT704 maximum wind speed)

2.3.8 Analog Output Signal for Wind Direction Channel
Ordering option 8 defines analog output signal for wind direction. WS425 Potentiometer
output is backward compatible when replacing WS425 with a WMT700 unit.

Table 12 Analog Output Signal for Wind Direction

Selection Output Configuration

0 Disabled

A Voltage output 20 mV/degree

0 mV = 0 degree

7200 mV = 360 degree

D Current output 50 uA/degree

0 uA = 0 degree

18 mA = 360 degree
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Selection Output Configuration

E Current output 4 … 20 mA (44.444 uA/degree)

4 mA = 0 degree

20 mA = 360 degree km/h

F WS425 Potentiometer output

0% of Vref= 0 degree

100% of Vref = 360 degree

More Information

‣ Coordinate Systems: Vector and Polar Calculations (page 34)

2.3.9 Connection Cables
Ordering option 9 defines connection cables.

Table 13 Connection Cables

Selection Cable type

1 No cables

2 Cable 2 m, cable connector, open leads on one end

3 Cable 10 m, cable connector, open leads on one end

4 MAWS cable 10 m

5 AWS520 cable 10 m. Shield connected to PE pin

6 Adapter cable for WS425 serial

7 Adapter cable for WS425 analog frequency output

8 RS485 cable 2 m, cable connector, open leads on one end

9 RS485 Cable 10 m, cable connector, open leads on one end

A Adapter cable for WS425 analog voltage output

B AWS520 cable 10 m. Shield not connected to PE pin.

C ROSA analog cable 10 m, cable connector, open leads on one end

D Junction Box with Cable 2 m

E Cable 15 m, cable connector, open leads on one end

F Cable 26 m, cable connector, open leads on one end

2.3.10 Mounting Adapters
Ordering option 10 defines mounting adapters.
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Table 14 Mounting Adapters

Option Adapter Type

A Adapter 228869 only. Standard adapter, no fix

B Adapter 228869 with WMT70FIX70 fixing mechanics. Also suitable for inverted
mounting. Standard adapter for general purpose

C Adapter 228869 with WMT700FIX60-POM. Standard adapter with plastic fix for 60 mm
pole

D Adapter 228869 with WMT700FIX60-RST Standard adapter with stainless steel fix for
60 mm pole

E Adapter 22877 only (used for old WS425 FIX30/WS425FIX60), WS425-compatible
adapter, no fix

F Adapter 228777 with WS425FIX60. WS425-compatible adapter with WS425FIX60

G Adapter 228869 with ASM212140 (suitable for mounting 4258057). ASOS mounting
adapter

Ordering option 11 is reserved for future use.

2.3.11 Accessories
Ordering option 12 defines WMT700 accessories.

Table 15 Accessories

Option Accessories

A No accessories

B Bird cage (WMT70BirdKit)

2.3.12 Manual
Ordering option 13 defines the available manual version and possible special package
design.

Table 16 Manual

Option Manual

1 No manual

2 English manual

3 Japanese manual
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Option Manual

4 Chinese manual

5 Russian manual

2.3.13 Example of WMT703 Configuration

Figure 8 Example of WMT703 Configuration

More Information

‣ Heating (page 48)

2.4 Accessories
WMT700 can be tailored to your needs with several accessories. The accessories include:

• Mounting adapters for different mast diameters
• Cables for different host systems and preferred communication types
• Bird prevention kit
• Field calibration kit
• Cable tightening tool
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2.4.1 Bird Cage

Figure 9 Bird Cage

Vaisala recommends using the optional bird cage (WMT70BirdKit) in areas with large bird
populations. The cage is designed to prevent large birds from disturbing the wind speed and
direction measurements.

You can install the bird cage on a mounted WMT700 without dismounting the wind sensor.
In cold climates, accumulated snow or ice on the bird cage can disturb the measurement. In
such conditions, perform frequent visual inspections of WMT700 to avoid ice or snow build-
ups.

2.4.2 Zero Wind Verifier

Figure 10 Zero Wind Verifier
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The optional WMT700 zero wind verifier (WMT70Verifier) is a small echo-free chamber for
testing the mechanical integrity of WMT700 and performing one-point calibration. The
verifier ensures that the array is undamaged and that the transducers are parallel to each
other. You can perform the verifier test also in the field.

2.4.3 Cables
Select the cables according to your operating environment.

Table 17 Cables

Order Code Description Purpose

WMT70Conn Cable connector Cable

227567SP Cable 2 m, cable connector, open leads
on one end

Used for analog output or serial communication
with two serial ports.

227568SP Cable 10 m, cable connector, open leads
on one end

Used for analog output or serial communication
with two serial ports.

237890SP Cable 15 m, cable connector, open leads
on one end

Used for analog output or serial communication
with two serial ports.

237889SP Cable 26 m, cable connector, open leads
on one end

Used for analog output or serial communication
with two serial ports.

228259SP RS-485 cable 2 m, cable connector,
open leads on one end

Used for serial communication with RS-485
interface.

228260SP RS-485 Cable 10 m, cable connector,
open leads on one end

Used for serial communication with RS-485
interface.

227565SP MAWS cable 10 m Used for connecting WMT700 to Vaisala Automatic
Weather Station MAWS.

229807SP AWS520 cable 10 m, shield connected
to PE pin

Used for connecting WMT700 to Vaisala Fixed Site
Observation System AWS520.

227566SP AWS520 cable 10 m, shield not
connected to PE pin

Used for connecting WMT700 to Vaisala Fixed Site
Observation System AWS520.

231425SP ROSA analog cable 10 m, cable
connector, open leads on one end

Used for connecting WMT700 to Vaisala Road
Weather System ROSA.

227569SP Adapter cable for WS425 serial Used for connecting the WS425 cable to WMT700.
Only applicable for retrofit installations.

227570SP Adapter cable for WS425 analog
frequency output

Used for connecting the WS425 cable to WMT700.
Only applicable for retrofit installations.

227571SP Adapter cable for WS425 analog
voltage output

Used for connecting the WS425 cable to WMT700.
Only applicable for retrofit installations.

ASM210719SP Junction Box with Cable 2 meters Used when a cable longer than 10 meters is needed.
Junction Box contains terminal blocks that extend
the 2-meter cable to a needed length.
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2.4.4 Cable Tightening Tool

Figure 11 Cable Tightening Tool

WMT700 is shipped with a cable tightening tool (237888SP). When you insert a cable in the
cable tightening tool, it is easier to grip and rotate. After tightening, you can leave the cable
tightening tool in place.
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3. Functional Description

3.1 Operating Principle
WMT700 uses the Vaisala WINDCAP ultrasonic sensor technology in wind measurement.
The sensor has an onboard microcontroller that captures and processes data and
communicates over serial interfaces.

The wind sensor has an array of three equally spaced ultrasonic transducers on a horizontal
plane. Wind speed (WS) and wind direction (WD) are determined by measuring the time it
takes the ultrasound to travel from each transducer to the other two.

The wind sensor measures the transit time (in both directions) along the three paths
established by the array of transducers. The transit time depends on wind speed along the
ultrasonic path. For zero wind speed, both the forward and reverse transit times are the
same. With wind along the sound path, the upwind direction transit time increases and the
downwind transit time decreases.

The following figure shows how the time shift of the ultrasonic signals is measured and how
tail wind and forward wind affect the measurement.
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Figure 12 Ultrasonic Measurement Principle

1 Ultrasonic measurement with zero wind
2 Impact of tail wind on ultrasonic measurement
3 Impact of head wind on ultrasonic measurement

The microcontroller calculates WS from the measured transit times using the following
formula:
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VW=0.5·L·(1/tf-1/tr)

VW Wind velocity

L Distance between two transducers

tf Transit time in the forward direction

tr Transit time in the reverse direction

Measuring the six transit times allows Vw to be computed for each of the three ultrasonic
paths. Using Vw values of two array paths is enough to compute WS and WD.

The different paths of WMT700 and the vectors provided by the wind sensor:

Figure 13 Measurement Paths of WMT700

1–6 Measurement paths 1 to 6 of WMT700
La, Lb, Lc Distance between two transducers

The vectors are calculated as follows:

Va=0.5·La·(1/A1-1/A2)
Vb=0.5·Lb·(1/A3-1/A4)
Vc=0.5·Lc·(1/A5-1/A6)
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The equation depends on the accurate distance of the measurement path (L). The computed
wind speeds are independent of altitude, temperature, and humidity, which are canceled out
when the transit times are measured in both directions, although the individual transit times
depend on these parameters.

3.2 Coordinate Systems: Vector and Polar
Calculations

The triangular geometry of the sensor is converted to orthogonal coordinates to achieve the
x and y components. Then the sensor converts the wind vectors into polar coordinates.

The measurement results are reported as follows:

• WMT700 reports WS (x, y) as two scalar speeds, one parallel to the N-S direction (x)
and the other (y) parallel to the W-E direction.

x = -WS × cos (WD)
y = -WS × sin (WD)

• WMT700 reports polar wind speed as a scalar speed in selected units (m/s, kt, mph,
km/h).

Polar wind direction is expressed in degrees (°). WMT700 indicates the direction that the
wind comes from. North is represented as 0°, East as 90°, South as 180°, and West as 270°.
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Figure 14 Wind Speed and Direction Presentations (Direction Offset Is 0)

More Information

‣ Analog Output Signal for Wind Speed Channel (page 21)

3.3 Wind Speed and Direction Averaging
WMT700 provides average values for wind speed and direction using either scalar or vector
averaging. With both methods, the average is determined according to the user-
configurable averaging time. The averaging time affects serial communication and analog
output similarly.

You can also configure the gust averaging time for calculating wind extreme values. The
default gust averaging interval is 3 seconds, as recommended by World Meteorological
Organization (WMO).

If you select scalar averaging, you can also enable wind direction coasting to ensure
consistent direction measurement results at low wind speeds.
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3.3.1 Scalar Averaging
When you select scalar averaging, WMT700 calculates wind speed and direction averages
by adding up each wind measurement from the averaging time and dividing the sum by the
number of measurements. The time between each consecutive wind speed and wind
direction measurement is 0.25 seconds.

Wind direction is a circular function with a discontinuity at North, where 360° is equal to 0°.
For example:

359° + 5° = + 4°
0° - 5° = 355°

WMT700 translates wind direction to a linear function to determine the wind direction
average. For example:

359° + 5° is translated to 364°, which is then further converted to +4° for output.

0° - 5° is translated to 355°.

This ensures that the wind direction average stays representative of the true situation even if
individual samples occur on both sides of the zero direction.

If the data acquisition system requests data before the initial averaging time completes, the
sensor returns the most recent complete measurement data.

The following figure shows an example of averaging wind direction when the measured
wind values are 355° and 10°. The resulting average is 2.5°.
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Figure 15 Example of Wind Direction Averaging

3.3.2 Wind Direction Coasting
Accurate wind direction measurement requires that the wind speed is sufficient. If you
enable wind direction coasting, WMT700 does not calculate wind direction when the wind
speed drops below the selected wind direction coasting threshold. The last calculated
direction output remains until the wind speed increases enough to reach the threshold and
WMT700 returns to normal operation.

3.3.3 Vector Averaging
When you select vector averaging, WMT700 calculates wind speed and direction averages
by adding up each x velocity and y velocity measurement from the averaging time and then
dividing the sum by the number of measurements. WMT700 converts the resultant average
x velocity and average y velocity to polar direction and magnitude, which returns the wind
direction average in degrees and wind speed average in the chosen units.

If the data acquisition system requests data before the initial averaging time completes, the
sensor returns the most recent complete measurement data.
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3.4 Measurement Methods
WMT700 measures wind speed and direction either continuously or for the duration of the
user-configurable averaging time. You can select the measurement mode over the serial
interface.

3.4.1 Continuous Measurement
You can set WMT700 to measure wind data continuously and stop the measurement with
the STOP command.

The following data communication methods are available:

• Poll Mode: You can fetch the most recent data from WMT700 with the POLL command.
You must specify the data message identification number in the command.

• Automatic Message Mode: If the automatic message interval is configured, WMT700
sends automatic data messages at selected intervals. The data message is user-
configurable.

More Information

‣ Serial Interface Timing (page 42)

3.4.2 Wind Measurement on Request
You can set WMT700 to measure wind speed and direction for a specified period of time.
The duration of the measurement can range from 0.25 seconds to 60 minutes, depending on
the configured averaging interval.

You can fetch the required data message from WMT700 in measurement mode with the
polling command. You must specify the data message in the command.

More Information

‣ Serial Interface Timing (page 42)

3.5 Host System Connections and
Interfaces

WMT700 always needs a host device for measurement data collection and presentation. The
host device is usually an automatic weather station, but other host devices such as data
loggers or personal computers can also be used.

WMT700 performs calculation, quality control, and data format procedures on the
measurement data. The processed data is sent to weather stations using serial ports and/or
analog output channels. The most commonly used communications interface is RS-485, but
WMT700 has a flexible set of interfaces ranging from RS-232 to voltage and current mode
analog signals.
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You can set WMT700 to send measurement data either as analog output or data messages
through a serial port, or you can use both outputs simultaneously. You can send operating
and configuring commands to WMT700 through the serial interface.

Operation and heating power is usually provided from one power supply. You can also use
separate power supplies for heating and operation to prevent the heating function from
consuming the operation power. In a split-supply system there can be a separate backup
power supply for the operating power supply.

The following figure shows the main software components and external interfaces of
WMT700.

Figure 16 WMT700 External Interfaces

More Information

‣ Typical System Environments (page 183)

3.6 Serial Communication and Analog
Output

The following functionality is preconfigured at the factory according to your order:

• Digital communication interface for COM2
• Digital communication profile for COM2
• Digital communication units
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• Analog output signals for wind speed channel (AOUT1)
• Analog output signals for wind direction channel (AOUT2)

3.7 Serial Communication
In WMT700, there are two serial communication ports:

• COM1: Service port (RS-485)
• COM2: Configurable digital communication interface

Both ports support the same commands, protocols, operations, and data messages. You can
use any computer or data logger with a serial port to send commands to WMT700 and to
receive measurement data.

3.7.1 Communication Interface
COM1 is a fixed RS-485 communication interface to be used as a service port.

COM2 is a flexible digital communication interface that is preconfigured according to your
order. The available options are:

• RS-232 (recommended up to 15 meter distance)
• RS-485 (recommended up to 1200 meter distance in point-to-point connection)
• RS-422 (recommended up to 1200 meter distance)
• SDI-12 (recommended up to 60 meter distance)

Note that the recommendations depend on communication speed and cable type. In
optimized environments even longer distances can be considered.

Regardless of the factory configuration, you can change the COM2 interface type by using
terminal software.

More Information

‣ Configuration Parameter Descriptions (page 187)
‣ Wiring (page 72)

3.7.2 Profiles
The digital communication profile is used to preconfigure WMT700 according to your order
at the factory. Depending on the preconfigured communication profile, the default settings
of the following parameters can be:

• Communication protocols
• Communication parameters

The preconfigured communication profiles are:

• WMT700
• ROSA - MES12
• WS425 - ASCII
• WS425 - NMEA Extended (version 0183)
• WS425 - SDI-12 (version 1.3)
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• WS425 – ASOS

Vaisala recommends the WMT700 profile for normal operation. The profile offers a wide
range of predefined and user-configurable data message formats, and it is developed for
WMT700.

The ROSA - MES12 profile is intended for connecting WMT700 to the Vaisala ROSA system.

The WS425 profiles can be used when upgrading from WS425 to WMT700.

More Information

‣ Command Set for WMT700 (page 181)

3.7.3 Protocols
In addition to the protocols preconfigured under standard profiles, there are additional
protocols available:

• WMT700
• WMT700 NMEA MWV
• SDI-12
• WS425 - ASOS
• WS425 - ASCII
• WS425 - NMEA Standard
• WS425 - WAT11
• MES12

More Information

‣ Parameter Handling Commands (page 102)

3.7.4 Measurement and Configuration Modes
The serial ports have two operation modes:

• The configuration mode is for configuring WMT700 settings over a serial connection.
The selected communication profile does not affect the available configuration
commands.

• The measurement mode is for operating WMT700. The available commands depend on
the selected profile. The port in the measurement mode can receive polling commands
and respond to them with data messages.

The following figure shows the configuration and measurement modes of both serial ports
provided by WMT700.
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Figure 17 Configuration and Measurement Modes

After power-up, WMT700 is in measurement mode.

More Information

‣ Command Set for WMT700 (page 181)
‣ Entering and Exiting Configuration Mode (page 100)
‣ OPEN — Entering Configuration Mode (page 100)
‣ CLOSE — Exiting Configuration Mode (page 101)

3.7.5 Serial Interface Timing
Depending on the selected interface, the serial data interface timing is as follows:
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• Interfaces RS-232, RS-485, RS-422: The figure below shows timing when WMT700 is
polled in the measurement mode.

Figure 18 Timing for RS-232, RS-485, and RS-422 Interfaces

The response delay t2 is user-configurable. In the configuration mode, some commands
have a longer response delay.

• SDI-12 interface: The timing is compliant with the SDI-12 standard. For the complete
SDI-12 standard text, see www.sdi-12.org.

3.8 Analog Output
Analog outputs are either enabled or disabled, and the output settings are preconfigured at
the factory according to your order. In analog output operation WMT700 takes
measurements according to the configured averaging time and synthesizes the analog
outputs of wind speed and wind direction with an update interval of 0.25 seconds.

You can use configuration parameters to change the analog output type, WMT700 scaling
or save power by disabling the analog output functionality.

WMT700 provides the following analog outputs:

• Aout1 for wind speed data
• Aout2 for wind direction data

To emulate the WS425 analog output, choose voltage output, frequency output, and
potentiometer.

More Information

‣ Configuration Parameter Descriptions (page 187)
‣ Operating WMT700 in WS425 Analog Output Mode (page 128)

3.8.1 Analog Output Types
Analog output for Wind Speed (Aout1) can be configured as:

• Voltage output
• Current output
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• Frequency output

• Push-pull output
• Pull-down output
• Pull-up output

Analog output for Wind Direction (Aout2) can be configured as:

• Voltage output
• Current output
• Potentiometer output

Figure 19 Frequency Output
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3.8.2 Analog Output Scaling
You can specify the transfer function between measured values and output analog values.
You can select the analog output type as well as the gain and offset used in the transfer
function.

Table 18 Factory Settings for Analog Wind Speed Output

Aout1 Selected Option Scaling/Gain Offset Error
Indication

Example

Voltage 0.1 V/m/s 0 V 10 V 0 V = 0 m/s

7.5 V = 75 m/s

Current 0 ... 20 mA 0.0002 A/m/s 0 A 0.022 A 0 mA = 0 m/s

15 mA = 75 m/s

Current 4 ... 20
mA

WMT701 0.00040000 A/m/s 0.004 A 0.002 A 4 mA = 0 m/s

20 mA = 40 m/s

WMT702 0.00024615 A/m/s 0.004 A 0.002 A 4 mA = 0 m/s

20 mA = 65 m/s

WMT703 0.00021333 A/m/s 0.004 A 0.002 A 4 mA = 0 m/s

20 mA = 75 m/s

WMT704 0.00017777777 A/m/s 0.004 A 0.002 A 4 mA = 0 m/s

20 mA = 90 m/s

Frequency Push-Pull 10 Hz/m/s 0 Hz 1000 Hz 0 Hz = 0 m/s

750 Hz = 75 m/s

WS425 - voltage 8 mV/mph

(0.017895 V/m/s)

0 mph 2 V 0 mV = 0 mph

1.344 V=168 mph

WS425 - frequency 5 Hz/mph

(11.185 Hz/m/s)

0 mph 1000 Hz 0 Hz = 0 mph

840 Hz =168 mph

Frequency Push (PNP) 10 Hz/m/s 0 Hz 1000 Hz 0 Hz = 0 m/s

750 Hz = 75 m/s

Frequency Pull (NPN) 10 Hz/m/s 0 Hz 1000 Hz 0 Hz = 0 m/s

750 Hz = 75 m/s

Table 19 Factory Default Settings for Analog Wind Direction Output

Aout2 Selected
Option

Scaling/Gain Offset Error Indication Example

Voltage 0.02 V/° 0 V 10 V 0 V = 0°

7.2 V = 360°
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Aout2 Selected
Option

Scaling/Gain Offset Error Indication Example

Current 0 … 20 mA 0.00005 A/° 0 A 0.022 A 0 mA = 0°

18 mA = 360°

Current 4 … 20 mA 000044444 A/° 0.004 A 0.002 A 4 mA = 0°

20 mA = 360°

Potentiometer
(WS425)

1/359*Vref /°

(0.0027855)

0 Vref

(1)

0 V = 0°

Vref = 359°

For a different scaling, change the gain and offset settings.

The scaling of the current output 4 … 20 mA depends on the sensor measurement range
(WMT701, WMT702, WMT703, or WMT704), while the 0 … 20 mA output has 0.2 mA/m/s
scaling for all the measurement ranges.

The following tables list the most common settings for different units.

Table 20 Common Transfer Function Settings for Aout1 (WS)

Output Signal Scaling/Units Setting for Gain Setting for Offset

Voltage 8 mV/mph

100 mV/m/s

0.017895

0.1

0

0

Current 0.2 mA/m/s 0.0002 0

Frequency 5 Hz/mph

10 Hz/m/s

11.185

10

0

WS425 - voltage 8 mV/mph 0.017895 0

WS425 - frequency 5 Hz/mph 11.185 0

Table 21 Common Transfer Function Settings for Aout2 (WD)

Output Signal Scaling/Units Setting for Gain Setting for Offset

Voltage 4 mV/°

20 mV/°

0.004

0.02

0

0

Current 50 uA/degree 0.00005 0

Potentiometer 359° = Aout ref 0.0027855 0
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You can configure output scaling or transfer function settings in a variety of ways by
changing the custom gain and offset. The basic measurement units are m/s and degrees.
The physical output units are V, A, and Hz. For the potentiometer, an output of 1 means 100%
of the Aout ref voltage.

The following formula illustrates the impact of gain and offset values on the produced
output:

o = y0 + k×s

o Produced analog output (V, A, Hz, 100%)

s Measured wind speed or direction (in m/s or °)

k Selected gain value

y0 Selected offset value

Example

• Output mode: voltage
• Offset: 0.0
• Gain: 0.1

With the above settings, the analog output voltage range is from 0 V (0 m/s) to 7.5 V (75
m/s). When the measured wind speed is 10 m/s, the output voltage is 1.0 V.

Output = 0.0 + 10 × 0.1 = 1.0 V

Example

• Output mode: current
• Offset: 0.004
• Gain: 0.0002

With the above settings, the analog output current range is 4 mA (0 m/s) ... 19 mA (75
m/s). When the measured wind speed is 10 m/s, the output current is 6 mA.

Output = 0.004 + 10 × 0.0002 = 6.0 mA

3.8.3 Limitations for Output Signals
You can specify the minimum and maximum values for analog output with the configuration
parameters. The output is fixed to the specified values, and the unit depends on the selected
analog output mode.
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Example

To limit the output 1 in voltage mode to a range of 0.1 … 5 V, set the analog output
minimum value to 0.1 and the analog output maximum value to 5. Type the following
commands:

S aout1minv,0.1 S aout1maxv,5

3.8.4 Missing Readings and Error Indication
If WMT700 is unable to measure the wind, it indicates a missing reading in the output. The
most common reasons for measurement problems are foreign objects (such as ice, birds, or
other foreign object) on the line of measurement or sound reflections from nearby objects
(such as wind tunnel walls).

The default error indication is an out-of-range signal that is more than 10 V or 20 mA but
other error settings can also be configured.

Example

To set analog output 1 error indication in voltage mode to 1 V, set the analog output error
value to 1. Use the following command:

S aout1err,1

More Information

‣ Configuration Parameter Descriptions (page 187)

3.9 Heating

To avoid injury, do not touch the heated parts of the wind sensor when
the heating is enabled.
WARNING!

WMT700 can include a heating functionality that ensures proper operation in cold
environmental conditions or in cases where snow and ice build-up is possible.
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In addition to the standard non-heated version, WMT700 can be preconfigured at the
factory according to your order:

• Heating for the transducers only
• Heating for both transducers and array arms
• Heating for body, transducers, and array arms

Make sure that the supply output power capacity is high enough especially when
transducers, array arms, and sensor body are equipped with heaters. Also, note that there
are individual connections for applying the heating voltage.

3.9.1 Heated Transducers
The heating functionality has a thermostatic control with temperature sensors in each
transducer. The control function keeps the transducer temperature above 0 °C and adds
heating power when necessary. Therefore, heating is only activated when there is a risk of
ice build-ups. If a sensor is blocked, WMT700 increases the heating power to melt the ice
and returns to lower power after a period of time.

You cannot change the heating parameters, but you can enable or disable the heating
functionality with configuration parameters. When heating voltage falls below 18 VDC, an
alarm is raised. Heating is automatically disabled if heating voltage falls below 15 VDC.

Regardless of heating voltage, the maximum heating power is limited to 40 W and the
average heating power is limited to 30 W. The maximum power control is achieved by
automatically sequencing the transducer heaters depending on a heating voltage. At low
heating voltages, all the transducers are heated simultaneously. At mid-range, two of the
transducers are heated. At high voltage end, a single transducer is heated at a time. A pulse
width modulation (PWM) scheme is used to control the average heating power.

3.9.2 Heated Transducers and Arms
In addition to heated transducers, the array arms can also be heated, which prevents ice
build-up on the arms.

The functional principle is the same as with the heated transducers only, but the maximum
heating power is limited to 200 W and the average heating power is limited to 150 W.
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3.9.3 Heated Body, Transducers, and Arms

To avoid injury, do not touch the heated parts of the wind sensor when
the heating is enabled.
WARNING!

The fully heated version of WMT700 is suitable for harsh weather conditions. It provides
heating for the sensor body, transducers, and arms.

The functional principle is the same with the heated transducers and arms. Body heating is
controlled independently of transducer and arm heating. The maximum heating power for
the fully heated WMT700 is 350 W and the average heating power is 250 W in harsh
weather conditions. The inner temperature of the unit is measured continuously. If the inner
temperature starts rising, body heating power automatically reduces to retain the optimum
inner temperature of WMT700.
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4. Installation

4.1 Installing WMT700

To prevent corrosion and oxidation, use copper paste or equivalent on screws and
connector threads.

4.1.1 Maritime Installations
In maritime installations according to IEC 60945, WMT700 belongs to installation category
C, which means that it is exposed to weather.

When making maritime installations, note the following:

• Do not install WMT700 near a magnetic compass. The compass safe distance is 5 m.
• Do not place WMT700 directly in front of a radar.
• Do not install WMT700 next to a powerful RF-transmitter antenna.

4.2 Placing WMT700
Install WMT700 on one of the following:

• Side of the mast
• Top of the mast
• Sensor support arm or cross arm

To prevent equipment damage, install an air terminal so that the tip is as
high above the instruments and sensors as possible.
CAUTION!

When selecting the mounting position and routing the sensor cable, take into account the
other equipment installed on the mast (for example, air terminals).

For the most reliable measurements:

• Avoid trees or other objects nearby which could disturb wind flow.
• Install the sensor to the height that best represents the prevailing wind conditions on

site.
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When deciding where to install the sensor, pay attention to the North arrow printed on
top of the sensor. The North arm is marked with an orange sticker.

If ice or snow accumulates on the mast, guy wires, or sensors, the ice or
snow can fall and cause injury to persons below.
WARNING!

4.3 Unpacking and Handling WMT700
WMT700 is shipped in a custom cardboard container with two plastic transportation
dampers. When unpacking WMT700, remove only the bottom damper that protects the
sensor body.

Never transport WMT700 without the custom shipping container.
Otherwise, the warranty becomes void.
CAUTION!
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Figure 20 Removing WMT700 Bottom
Transportation Damper

Do not remove the upper transportation damper that protects the array
until you have installed the sensor.
CAUTION!

Handle with care. Any impact on the instrument or sensor array may cause
damage and lead to incorrect measurements.
CAUTION!

Figure 21 Handling WMT700
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4.4 Connecting WMT700 Cable
When installing WMT700, route the cable according to the mounting option. When
mounting to a mast, you can the route cable either outside or inside the mast. Cable routing
depends on the mast type and other equipment, such as air terminals, installed on the mast.

Make sure that you prepare or connect only de-energized wires.WARNING!

Do not perform installation or maintenance procedures when there is a
risk of thunderstorm or lightning activity in the area.
WARNING!

A long cable between units (sensors, transmitters, power supplies, and
displays) can cause a lethal lightning-induced current surge. Always ground the
enclosure to a suitable grounded location with a short, low-resistance cable.

WARNING!

Make sure that the cable is properly attached to the mast or cross arm
before starting the installation. Otherwise, it may slip and fall down during the
installation procedure.

CAUTION!

To avoid strain on the connector, make sure you connect the cable properly.
Too much strain may cause the cable to fall off, damage the cable or connector, or make
the cable or connector susceptible to water leakage.

CAUTION!
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The recommended minimum bending radius for the cable is 70 mm (2.76 in).

1. If you are using the cable tightening tool, insert the cable in the tool. 
Vaisala recommends that you use the cable tightening tool. The ribbed part of the tool
offers a better grip of the cable when tightening the connector. You do not need to
remove the tool when the connector is tightened.

1 Cable tightening tool
2 Cable

2. If you are not using the cable tightening tool, remove the mounting adapter from the
sensor body, and lead the sensor cable through the mounting adapter. 
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3. Connect the cable to WMT700. Tighten the cable by rotating the tightening tool or the
ribbed part of the connector clockwise by hand. Make sure that the connector is
properly tightened before proceeding to the next step. 

1 WMT700
2 Cable tightening tool
3 Cable

Do not use tools when tightening the connector.CAUTION!

To avoid water leakage and damage to the sensor, verify that the
connector is properly tightened. If water leaks into the connector, this voids the
warranty for the sensor.

CAUTION!
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4. If you removed the mounting adapter, fasten it to the sensor by rotating the adapter
clockwise. Tighten the three screws at the bottom of the sensor. 

4.5 Mounting WMT700 on Vertical Pole
Mast

• 5-mm Allen key
• Adjustable wrench

You can mount WMT700 on a 30‑mm (1.18‑in) or a 60‑mm (2.36‑in) pole mast. The
WMT70FIX mounting kit contains U bolts for both kinds of pole masts (2 pcs each).

You can place WMT700 either on the side or on top of the mast. When selecting the
mounting position, take into account:

• Other equipment installed on the mast (for example, air terminal)
• Cable routing (inside or outside the mast)

1. Make sure that the cable is firmly connected to the sensor.
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2. Assemble the WMT70FIX mounting kit, and attach it to the mast with the U bolts. 

Figure 22 Mounting WMT700 on Side of Mast

When mounting the sensor on the side of the mast, make sure that the mounting kit
is positioned at the top level of the mast.

Figure 23 Mounting WMT700 on Top of Mast

3. Check that the mounting kit is level, and tighten the U bolts slightly. 

Do not tighten the bolts too much at this stage. You still need to rotate the mounting
kit to align the sensor after the installation.

4. Haul the sensor up.
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5. Holding the sensor from its body, run the cable through the WMT70FIX mounting kit,
and slide the sensor into the mounting kit. 
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6. To avoid misalignment, turn the sensor until the mounting screw reaches the far end of
the slot, and tighten the screw. Tightening torque 5 Nm. 

1 WMT700 mounting screw
2 U-bolt and nut (M8 DIN934 A4) in horizontal slot

7. To align the sensor, rotate the mounting bracket.

More Information

‣ Aligning WMT700 (page 63)

4.6 Mounting WMT700 on Sensor
Support Arm or Cross Arm Using
WMT70FIX

• 5-mm Allen key
• Adjustable wrench

When mounting WMT700 on a horizontal sensor support arm or cross arm using the
WMT70FIX mounting kit, place WMT700 with the array facing up or down.
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Mounting WMT700 with the array facing down protects the sensor better against the
accumulation of snow and interference from birds. The adapter drains located at the bottom
of WMT700 prevent water from accumulating inside the mounting adapter.

1. Make sure that the cable is firmly connected to the sensor.

2. Attach the WMT70FIX mounting kit to the sensor support arm or cross arm with the
U bolts and insert the U bolts in the slots of the mounting kit. 

3. Check that the mounting kit is not tilted to either side and tighten the U bolts firmly.

4. Haul the sensor up.
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5. Holding the sensor from its body, run the cable through the mounting kit, and slide the
sensor into the mounting kit. 
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6. To avoid misalignment, turn the sensor until the screw reaches the far end of the slot,
and tighten the screw. 

1 WMT700 mounting screw. Tightening torque 5 Nm.
2 U-bolt and nut (M8 DIN934 A4) in horizontal slot

7. Align the sensor.

If you installed the sensor with the array facing down, configure WMT700 accordingly.

More Information

‣ Aligning WMT700 (page 63)

4.7 Aligning WMT700

• 5-mm Allen key
• Compass

WMT700 is permanently marked with the letter N and a North arrow. The North arm is
marked with an orange sticker.
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Figure 24 WMT700 North Arrow

Do not remove the instrument or sensor from the mounting kit during alignment.

1. Remove the transportation damper that protects the array and store it for future use.

2. To align the sensor, use a compass or other similar method to rotate the sensor so that
the North arrow points North. 

3. Tighten the bolts of the mounting kit. Tightening torque 5 Nm.

4. If you cannot align WMT700, measure the deviation angle from North and configure
the wind direction offset error.

Connect the cable to the data acquisition system and power supply.
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4.7.1 Configuring Wind Direction Offset
If you cannot align the sensor so that the arrow points North, make a wind direction offset
by configuring the deviation angle in the sensor.

1. Mount the sensor to the desired position.

2. Define the deviation angle from the North (zero) alignment. 

3. Type the wind message formatting command and the deviation angle S
wndDirOffset,(angle). Indicate the direction from the North line with + or -. 

The sensor transmits the wind direction data by using the changed zero alignment.

More Information

‣ Configuration Parameter Descriptions (page 187)

4.7.2 Analog Output Parameter for WMT700 in Tunnels and
Cranes

Analog outputs can be used in road and rail tunnel applications as well as crane applications.

You can get horizontal and direction data with the parameter aout_map. The aout_map
parameter defines how analog output signals are used. WMT700 provides the following
analog outputs:

• aout1 for wind speed data
• aout2 for wind direction data

Table 22 aout_map Values

Parameter Definition

0 aout1, wind speed

aout2, wind direction (default)
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Parameter Definition

1 aout1, North-South, x component

aout2, West-East, y component

Typically, only the component x is used.

2 aout1, wind speed

aout2, wind speed alarm

A digital output: hi when wind speed > aout2_0

The following table shows the relationship between polar representation and the x and y
vector components.

Table 23 Wind y and x components at Different Wind Direction Angles

Wind Speed Wind Direction x Component y Component

1 0 -1 0

1 90 0 -1

1 180 1 0

1 270 0 1

4.7.2.1 Tunnel Application

In the tunnel application, airflow can be presented with one mA output channel, because
airflow goes along the tunnel. Typically, a relatively long average time (time constant) for
wind speed parameter is applied.

The sensor must be installed in a tunnel so that the sensor’s North is aligned with the tunnel.
The Aout1 channel (x component) provides the airflow in the tunnel. The following figure
shows a typical WMT700 installation in a tunnel.
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Figure 25 WMT700 in Tunnels

The following figure shows the 4…20 mA output as a function of airflow. The zero value is in
the middle of the output scale (12 mA). When airflow increases from 0 m/s towards North,
mA output reduces from 12 mA linearly resulting in 4 mA with 20 m/s wind. Similarly, when
airflow increases from 0 m/s towards South, mA output increases from 12 mA linearly
resulting in 20 mA with 20 m/s wind.

Figure 26 mA Output in Tunnels
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The parameter aout_map with setting 1 is used to get the North-South component of wind.

s aout_map,1
The North-South component to Aout1, the current output, -20 ... 20m/s to 4 … 20mA, Aout2
disabled:

s aout1_g,0.0004 
s aout1_o,0.012 s
aout1maxv,0.020
s aout1minv,0.004
s aout1mode,0
s aout1err ,0.002 s
aout2mode,7

4.7.2.2 Crane Application

In the crane application, WMT700 can provide wind speed value and to drive alarm signals
with 2 mA output channels. The WMT00 alarm output signal can be connected to external
audible or visible devices to trigger wind speed alarm for user-defined limits.

Two analog channels are required for this application:

• Channel 1 provides the wind speed value
• Channel 2 provides the alarm signal

Figure 27 Analog Output for Wind Speed and Wind Speed Alarm

The wind speed value can be scaled according to the sensor’s measurement range. The
alarm signal operates with on/off-mode. The alarm threshold can be adjusted. The following
figure shows the relation of outputs.
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Figure 28 mA Output in Cranes

The aout_map with setting 2 is for getting the wind speed value and the alarm signal. The
wind speed value in the Aout1 channel activates the wind speed alarm when the wind speed
value exceeds the set limit value.

s aout_map,2
The analog output 2 works as digital output. aout2_o sets the threshold wind speed
(ws_tresh, unit [m/s]) to 20 m/s:

s aout2_o,20
s aout2_g,1
To invert the logic signal, type:

s aout2_g,-1.

aout1 gives wind speed 4 … 20 mA output. aout2 gives 0 mA when the wind speed is <
20m/s, otherwise 20 mA.
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s aout_map,2
s aout1_g,0.000044444
s aout1_o,0.004
s aout1maxv,0.020
s aout1minv,0.004
s aout1mode,0
s aout1err ,0.002
s aout2_g,1
s aout2_o,20
s aout2maxv,0.020
s aout2minv,0.000
s aout2mode,4
s aout2err ,0.00

4.8 Installing Bird Cage
Install the bird cage on top of the wind sensor.

In cold climates, take into account that accumulated snow or ice on the bird cage can disturb
the measurement. In such conditions, visit the site frequently to clear ice and snow build-up.

Make sure that you do not damage the WMT700 array when installing the
bird cage.
CAUTION!
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Figure 29 WMT700 Bird Cage and Bird Cage Straps

1 Bird cage
2 Bird cage straps
3 Wind sensor
4 Guide for attaching the straps
5 Latch for attaching the straps

1. Unpack the bird cage and the straps.

2. Position the bird cage on top of the wind sensor and press the kit down until the three
hooks are in contact with the transducer arms.

3. Run the lower strap through the three guides in the kit.

4. Lift the latch screw, insert the strap to the latch, and press down the latch screw.

5. To tighten the screw, turn it clockwise with a screw driver or a socket. Do not over-
tighten.

6. Run the upper strap through the three guides in the kit, and repeat step 4 and step 5
for it.

4.8.1 Installing Bird Net
In areas with large populations of small birds, you can install a bird net over the bird cage.

1. Cover the bird cage with the bird net.

2. Tighten the bird net with cable ties.
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3. Cut off the excess net below the cable ties. 

1 Bird net

4.9 Wiring
The 17-pin M23 male connector is located at the bottom of WMT700. The connector is used
for power supply, digital communications, and analog outputs. The signals related to digital
communications are galvanically separated from the ground. The connector type is Hummel
7.106 series.

More Information

‣ Upgrading from WS425 to WMT700 (page 88)

4.9.1 Cables
Ready-made cables are available for use with Vaisala MAWS and AWS520 systems. These
cables have connectors on both ends. There is also a retrofit cable for Vaisala ROSA system
in case analog output has been used with WS425.

Vaisala provides open-lead cables for connections to other host systems:

• Cable 2 m (227567SP)
• Cable 10 m (227568SP)
• RS485 Cable 2 m (228259SP)
• RS485 Cable 10 m (228260SP)
• ROSA Cable 10 m for Analog Outputs (231425SP)
• Junction Box with Cable 2 m (ASM210719SP)

Cable 2 m and Cable 10 m carry through all signals from WMT700 while the RS-485 cables
are designed for RS-485 operation with a limited number of wires. The ROSA Cable is
intended for replacing WS425 with WMT700 in the Vaisala ROSA system if WS425 is
connected using analog outputs. The Junction Box is designed mainly for maritime RS-422
operation but it can be used whenever a connection longer than 10 meters is needed as an
entry point for an extension cable.
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Wire colors in the tables are not applicable to other cables.

If there are unused wires, make sure that they are unconnected and protected. Do not cut
off any wires.

4.9.2 Cable 2 m, Cable 10 m, Cable 15 m, and Cable 26 m
The following table shows how to connect:

• Cable 2 m (227567SP)
• Cable 10 m (227568SP)
• Cable 15 m (237890SP)
• Cable 26 m (237889SP)

Table 24 Connecting Cable 2 m, Cable 10 m, Cable 15 m, and Cable 26 m

Power Supply Wire Colors Pin

Operating Power Supply White 1

Operating Power Supply Ground Gray-Pink 11

Heater Power Supply Gray 5

Heater Power Supply Pink 6

Heater Power Supply Ground Blue 7

Heater Power Supply Ground Red 8

Enclosure Ground Shield Shield

Analog Outputs   

Analog Output AOUT2, Wind Direction Brown 2

Analog Output AOUT1, Wind Speed White-Green 13

Reference Input for AOUT2 (simulated potentiometer) White-Gray 17

Analog Output Ground Red-Blue 12

COM port RS-232 RS-422 RS-485 SDI-12   

COM2 RS232Rx Rx– Rx– - Green 3

 RS232Tx Tx– Tx– Data Yellow 4

 - Tx+ Tx+ - Brown-Green 14

 - Rx+ Rx+ - White-Yellow 15

COM1 and COM2 Communication Ports Ground Violet 10
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Power Supply Wire Colors Pin

COM1(Service
Port)

RS-485 – Black 9

 RS-485 + Brown-Yellow 16

4.9.3 RS-485 for COM2 with Cable 2 m and 10 m
In the RS-485 mode, the same signals as in the RS-422 mode are available at the end of
Cable 2 m and Cable 10 m. Make two-wire loop-backs at the end of the cable.

Figure 30 COM2 RS-485 Wiring

Table 25 COM2 RS-485 Wiring

WMT700 Signals Wire Colors Pin RS485 Signals

RxB Green 3 -

TxB Yellow 4

TxA Brown-Green 14 +

RxA White-Yellow 15

To avoid confusion, the RS-485 and RS-422 signals of WMT700 are named as follows:

• Inverting: –
• Non-inverting: +

According to the EIA-485 standard, the lines are named as follows:

• Inverting: – <=> A
• Non-inverting: + <=> B

The A/B naming used by some manufacturers is in conflict with the standard. To ensure
proper operation, verify the polarity of the signals when using the device on the bus with
signals named as A/B. Opposite polarity causes data inversion on the bus, but it does not
damage the device.
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4.9.4 RS-485 Cable 2 m and RS-485 Cable 10 m
RS-485 Cable 2 m and RS-485 Cable 10 m are designed for the standard connection:
operating power, heater power, and RS-485. The two-wire RS-485 loopback connections are
preconnected inside the cable.

Table 26 Connecting RS-485 Cable 2 m (228259SP) and RS-485 Cable 10 m (228260SP)

Power Supply Wire Colors Pin

Operating Power Supply White 1

Operating Power Supply Ground Gray-Pink 11

Heater Power Supply Gray, Green, Pink 5, 6

Heater Power Supply Ground Blue, Black, Red, Yellow 7, 8

Enclosure Ground Shield Shield

COM2   

RS485 - Brown 3,4

RS485 + Red-Blue 14, 15

Communications Ground Violet 10

4.9.5 Connector Signals
The following figure and table show the pin-out of the 17-pin M23 connector. The serial
output type of COM2 depends on the sensor configuration. Analog outputs are always
available from the connector.

Figure 31 Pins for 17-Pin M23 Connector
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Table 27 Pin-Out for 17-Pin M23 Connector

Pin Description RS-232 RS-422 RS-485 SDI-12

1 Operating Power Supply

2 Analog output AOUT2, Wind Direction

3 COM2 RS232Rx Rx– Rx– -

4 RS232Tx Tx– Tx– Data

5 Heater Power Supply

6 Heater Power Supply

7 Heater Power Supply Ground

8 Heater Power Supply Ground

9 COM1 (Service
Port)

RS-485-

10 COM1 and COM2 Communication Ports Ground

11 Operating Power Supply Ground

12 Analog Output Ground

13 Analog Output AOUT1, Wind Speed

14 COM2 - Tx+ Tx+ -

15 - Rx+ Rx+ -

16 COM1 (Service
port)

RS-485+

17 Reference Input for AOUT2 (simulated potentiometer)

Shield Enclosure Ground

4.10 Powering
WMT700 has separate power supply inputs for operating and heating power. The inputs are
usually connected to the same 24 VDC power supply unit, but special applications such as
battery operation or battery back-up may require separate supplies.

The operating power has one supply terminal and one ground terminal, while the heating
power has two supply terminals and two ground terminals allowing a higher supply current.
All supply ground terminals are internally connected to each other.

In a system setup with two separate power supplies, avoid ground potential differences
between the supplies. Connect the negative terminals together if necessary.
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Some DC power supplies are based on a chopper circuit that operates at a 100 kHz
frequency. Avoid using such power supplies with WMT700. The measurement can be
distorted by the ripple in the DC output.

4.10.1 Operating Power
WMT700 can use any 9 ... 36 V (nominal voltage 24 V) minimum 2 W DC power supply that
meets applicable safety regulations. Connect heating supply wires to the ground in case
heating is not used. The typical current and power consumptions vs. operating voltage are
shown in the following figures. Note that the selected heating option affects the needed
operation voltage when separate powering for operation and heating is used.

Do not use a DC power supply based on a chopper circuit that operates at 100 kHz. The
ripple in the DC output can distort the measurement.

Table 28 Operating Power Supply Voltage Requirements

Used Heating Option Operating Power Supply

Transducers 12 … 36 VDC 30 W

Transducers and arms 14 … 36 VDC 150 W

Transducers, arms, and body 16 … 36 VDC 250 W

Figure 32 Wiring of Non-heated WMT700 Versions
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In maritime environments, the normal input voltage ranges are: operating voltage
10 … 30 VDC (-10% … +30%) and heating voltage 24 … 30 VDC (-10% … +30%), as defined
in the maritime standard IEC 60945.

Figure 33 Operating Supply Current Consumption
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Figure 34 Operating Supply Power Consumption

More Information

‣ SLEEP — Enter Low-Power Mode (page 127)

4.10.2 Heating Power
The following table shows the minimum power supply requirements of the WMT700 heating
options.

In maritime environments, the normal input voltage ranges are: operating voltage
10 … 30 VDC (-10% … +30%) and heating voltage 24 … 30 VDC (-10% … +30%), as defined
in the maritime standard IEC 60945.

Table 29 Heating Power Supply Requirements

Heating Option Heating Voltage Required Heating Power
Supply

None - -

Transducers 24 … 36 VDC 40 W

Transducers and arms 24 … 36 VDC 200 W

Transducers, arms and body 24 VDC 350 W (2 m cable)
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4.10.2.1 Power and Cable Recommendations for Fully Heated WMT700

The following table shows cable and power recommendations. If you need a longer than a 10
meter cable, Vaisala recommends using Junction Box with Cable (WMT70CABLE12) for
extending the cable length.

The minimum operation voltage for a fully heated WMT700 (transducers, arms, and body
heated) is 16 V, if a separate power supply unit is used for operation.

Table 30 Heating Power and Extension Cable

Wire Type/
Cable Length

2 m
WMT70CABLE1)

10 m
WMT70CABLE21)

20 m 30 m 40 m

0.5 mm2/
AWG20

24V 400 W 28 V 400 W - - -

1 mm2/AWG17 - - 28V 400 W 30 V 400 W 32 V 400 W 2)

1.5 mm2/
AWG15

- - - - 30 V 400 W

1) Vaisala standard connection cable
2) Not for maritime use

The following figures illustrate the wiring of heated WMT700 instruments.

Figure 35 Wiring of Heated WMT700 Versions, Part 1
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Note that when using separate power supplies for operating and heating, the minus (-)
terminals of the power supplies are connected together by an additional wire. Use a
minimum 0.75 mm2 wire for connecting the (-) terminals together.

Figure 36 Wiring of Heated WMT700 Versions, Part 2

There are two terminals connected in parallel for both positive and negative
rails of the heating voltage for the maximum current capacity. In case the connection
cable has parallel supply wires, they all have to be connected to ensure current capacity.
Leaving one terminal unconnected or connecting it to the ground may cause a WMT700
malfunction or a short circuit in the power supply.

CAUTION!

Always use cables that meet the minimum dimension requirements. Long cables with thin
wires cause power losses in the cable and significantly decrease the heating capabilities of
WMT700. Loop resistance of 0.15 Ω results in approximately 1 V drop in heating voltage
with 200 W heating. You should note this to get proper heating capability. For example,
the loop resistance of a 10 m cable (227568SP) is 0.7 Ω resulting in an approximately 4 V
drop. It is recommended that you use at least a 28 V supply for the maximum heating
capability.

4.10.2.2 Maximum Peak Power

The heaPeakPwr parameter sets WMT700 maximum peak power (in Watts). WMT700 has
3 heater resistors for each arm. The heaPeakPwr parameter determines how many
resistors are on at the same time. WMT700 measures the supply voltage and calculates the
maximum allowed number of heaters from the supply voltage and heater resistance. The
heaPeakPwr parameter does not limit the power in the body heater of a heated version of
WMT700.

Make sure the WMT700 power peak limit is lower than the power supply rating. Setting
heaPeakPwr value too low reduces heating performance.
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Use a power supply that has enough power for WMT700. Part of the power is dissipated in
the cables.

Table 31 Sensor Power of Different Heating Options

Heating Option Required Sensor Power Parameter Values

Transducers 40 W 0 ... 40

Transducers and arms 200 W 0 ... 200

Transducers, arms, and body 350 W 0 ... 350

4.10.2.3 Body Heating Power Adjustment

The heaBMaxPower parameter sets WMT700 maximum body heater power (in Watts).

You can disable WMT700 body heating by setting the heaBMaxPower parameter value to
0. The default value is 150.

Table 32 heaBMaxPower Parameter Values

Body Heating Parameter Value

Off 0

On 150

4.11 Upgrade from WS425 to WMT700
When upgrading to WMT700, there are the following installation options:

• Basic installation, which consists of mounting WMT700 with the FIX70 mounting kit
and the WMT700 mounting adapter.
Uninstall the WS425 wind sensor and mounting kit. and follow the installation
instructions in 4.1 Installing WMT700 (page 51).

• Retrofit installation, which consists of mounting WMT700 with a WS425 mounting kit
and the WMT700 mounting adapter for FIX30/60.

At the measurement site, mount WMT700 and connect it to the power source and data
acquisition system.

After upgrading to WMT700, you can install the optional bird prevention kit available for the
wind sensor.
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To protect personnel and the wind sensor, install an air terminal with the
tip at least one meter above WMT700. The air terminal must be properly grounded,
compliant with all local applicable safety regulations. Do not install the wind sensor
above the top of the air terminal.

WARNING!

Do not perform installation or maintenance procedures when there is a
risk of thunderstorm or lightning activity in the area.
WARNING!

Handle with care. Any impact on the instrument or sensor array may cause
damage and lead to incorrect measurements.
CAUTION!

Save the container and all the packaging materials for future transporting or shipping.

4.11.1 Mounting with WS425 Mounting Kit
You can mount WMT700 either on a vertical pole mast or a horizontal cross arm using the
WS425 mounting kit. The procedure for both mounting options is identical. Typically you
can upgrade from WS425 to WMT700 without removing the mounting kit.

If you remove the mounting kit, you must align the wind sensor after mounting. To
facilitate the aligning process, mark both the wind sensor and the mounting kit with a
marker pen before removing the mounting kit. You can use the mark as a rough reference
when starting the aligning process described in 4.7 Aligning WMT700 (page 63).

When mounting WMT700 to a cross arm, the wind sensor can be placed with the array
facing up or down. If the wind sensor is installed with the array facing down, you must
configure WMT700 accordingly. See 5.3 Configuration (page 101).
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The following figure shows the mounting procedure to a vertical pole mast.

Figure 37 Retrofit Installation to Pole Mast

1 WMT700
2 Mounting adapter for FIX30/60
3 Mounting screw
4 WS425 mounting kit
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The following figure shows the mounting procedure to a horizontal cross arm.

Figure 38 Retrofit Installation to Cross Arm with Array Facing Up

1 WMT700
2 Mounting adapter for FIX30/60
3 Mounting screw
4 WS425 mounting kit
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Figure 39 Retrofit Installation to Cross Arm with Array Facing Down

1 Mounting adapter for FIX30/60
2 WS425 cross arm
3 WMT700

4.11.2 Upgrade Prerequisites
You need the following components:
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• Correct mounting kit (already attached to the mast) for a retrofit installation. The
following figure shows the available options: FIX30 and WS425FIX60 mounting kits.

Figure 40 FIX30, WS425FIX60-RST, and WS425FIX60-POM

• Correct mounting adapter for your installation: FIX30, WS425FIX60-POM, or
WS425FIX60-POM. The diameter of the mounting adapter for the adapters is 61 mm.
Change the mounting adapter if necessary. If you are not sure that you have the correct
mounting adapter, contact Vaisala.

Figure 41 Mounting Adapter for FIX30, WS425FIX60 (Left), and Mounting Adapter for
FIX70 (Right)

• Correct cables for the mounting kit and analog output/serial communication. The table
below lists the available cables for a retrofit installation. The In/Out stands for the
possibility to route the cable either inside or outside of the mast.

If you have FIX30, do not use the adapter cables but order the appropriate WMT700
cable. The adapter cable does not fit inside the mast.
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Table 33 Mounting Kits and Cable Codes

Description Spare Part Item FIX70 FIX30 WS425FIX60

  In Out In Out In Out

WMT700 cables
with open leads one
end (Standard 2 m/
10 m/15 m/26 m,
RS485 2 m/10 m,
ROSA analog 10 m)

227567SP x x x  x x

227568SP x x x  x x

237890SP x x x  x x

237889SP x x x  x x

231425SP x x x  x x

228259SP x x x  x x

228260SP x x x  x x

WMT700 cables
with connectors on
both ends (MAWS,
AWS520):

227565SP x x x x x x

229807SP x x x  x x

227566SP x x x  x x

4.11.3 Upgrading from WS425 to WMT700

1. Uninstall WS425.

2. Depending on your cable type, do one of the following:

• Run a WMT700 cable through the WS425 mounting kit and connect it to WMT700.
• If you use a WS425 cable, make sure the pre-installed O-ring seal sits properly in the

plastic male connector between the WS425 cable and the adapter cable. Connect
the WS425 cable to the WS425 adapter cable, run the adapter cable through the
WS425 mounting kit, and connect the cable to WMT700.

WMT700 User Guide M211095EN-H

88



3. Tighten the connector by rotating the connector by hand clockwise. 

Make sure that the connector is properly tightened before proceeding to the next step.
If you cannot tighten the connector, loosen the mounting adapter fixing screws, remove
the mounting adapter, and connect the cable. Reattach the mounting adapter.

4. Attach the WMT700 sensor body to the WS425 mounting kit and tighten the bolt.

5. Remove the transportation damper protecting the array and store it for future use.

6. Connect the cable to the data acquisition system and power supply. 
Vaisala recommends that you use the cable tightening tool. The ribbed part of the tool
offers a better grip of the cable when tightening the connector. Insert the cable in the
cable tightening tool and rotate the ribbed part of the connector by hand. You can
leave the connector in place.

1 WMT700
2 Cable tightening tool
3 Cable

7. Connect the wires. 
WMT700 is now ready for operation.

More Information

‣ Wiring (page 72)
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4.11.4 Mounting WMT700 with ASOS Mounting Adapter
You can mount WMT700 on your existing 425NWS installation kit (4258057) by using the
ASOS mounting adapter (ASM212140).

The following figure shows the parts of the installation.

Figure 42 Installing with ASOS Mounting
Adapter

1 WMT700
2 Adapter for WMT700FIX, WMT700FIX-

POM, and WMT700FIX60-RST (228869)
3 ASOS mounting adapter (ASM212140)
4 425NWS sensor alignment adapter
5 425NWS mounting tube

1. Remove the screw from the ASOS mounting adapter. 
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2. Insert the ASOS mounting adapter into the WMT700 adapter (228869). The ASOS
adapter slides into position.

1 Adapter for WMT700FIX,
WMT700FIX-POM, and
WMT700FIX60-RST (228869)

2 ASOS mounting adapter
(ASM212140)

3. Rotate the adapter until the screw holes are aligned. Insert the screw and tighten it.
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4. Mount WMT700 with the ASOS mounting adapter on the existing sensor alignment
adapter. 

1 WMT700 mounting adapter
2 Existing 425NWS alignment adapter

5. Align the screw holes, insert the screw, and tighten it.

4.11.5 Connection Cable Prerequisites
When installing WMT700, pay attention to the following issues:

• How to route the cables of your mounting option. When mounting to a mast, the cable
can be routed either outside or inside the mast depending on the mast type and other
equipment, such as air terminals, installed to the mast.

• Make sure that the cable is properly attached to the mast or cross arm before starting
the installation. Otherwise, it may slip and fall down during the installation procedure.

• Make sure to attach the cable properly to avoid strain on the connector. Too much strain
may cause the cable to fall off, damage the cable or connector, or make the cable or
connector susceptible to leakage. The recommended minimum bending radius for the
cable is 70 mm.
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Make sure that you prepare or connect only de-energized wires.WARNING!

Do not perform installation or maintenance procedures when there is a
risk of thunderstorm or lightning activity in the area.
WARNING!

A long cable between units (sensors, transmitters, power supplies, and
displays) can cause a lethal lightning-induced current surge. Always ground the
enclosure to a suitable grounded location with a short, low-resistance cable.

WARNING!

4.11.6 Wiring in Retrofit Installations
There are two ways of performing WMT700 retrofit installation:

• Using standard WMT700 cables
• Using WS425 cables with adapters

To avoid unnecessary connectors and maximize long-term reliability, Vaisala recommends
that you use the WMT700 cable for the retrofit installation.

4.11.6.1 Using Standard WMT700 Cables

This is the recommended way for the retrofit installation. There are various cables available
for the installation:

• Cable 2 m (227567SP)
• Cable 10 m (227568SP)
• Cable 15 m (237890SP)
• Cable 26 m (237889SP)
• RS-485 Cable 2 m (228259SP)
• RS-485 Cable 10 m (228260SP)
• ROSA Cable 10 m for Analog Outputs (231425SP)
• MAWS Cable 10 m (227565SP)
• AWS520 Cable 10 m, Shield connected to PE pin (229807SP)
• AWS520 Cable 10 m, Shield not connected to PE pin (227566SP)

4.11.6.1.1 ROSA Cable 10 m (Analog Outputs)

The ROSA Cable 10 m (231425SP) is intended for replacing WS425 with WMT700 in the
Vaisala ROSA system in case the WS425 has been connected using analog outputs. The
following table shows the wire colors and related signals on WMT700.
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Note that there are serial port signals available for configuration purposes on the cable even
though they are not used as operational. The unused wires must be properly isolated and
terminated to avoid unwanted operation or failure.

Table 34 ROSA Cable 10 m (231425SP)

Power Supply Wire Colors Pin

Operating Power Supply White 1

Operating Power Supply Ground Gray-Pink 11

Heater Power Supply Gray 5

Heater Power Supply Pink 6

Heater Power Supply Ground Blue 7

Heater Power Supply Ground Red 8

Enclosure Ground Shield Shield

Analog Outputs   

Analog Output AOUT2, Wind Direction Brown 2

Analog Output AOUT1, Wind Speed White-Green 13

Reference Input for AOUT2 (simulated potentiometer) White-Gray 17

Analog Output Ground Red-Blue 12

COM port RS-232 RS-485   

COM2 RS232Rx Rx- Green 3

 RS232Tx Tx- Yellow 4

 - Tx+ Brown-Green 14

 - Rx+ White-Yellow 15

COM1 and COM2 Communication Ports Ground Violet 10

COM1(service port) RS-485, - Black 9

 RS-485, + Brown-Yellow 16

4.11.6.2 Using WS425 Cables with Adapters

If a retrofit installation using WMT700 cables is not possible, there are adapters available for
most situations.

• Adapter Cable for WS425 Serial (227569SP)
• Adapter Cable for WS425 Analog Frequency Output (227570SP)
• Adapter Cable for WS425 Analog Voltage Output (227571SP)

The adapter cable specifications in this section apply for both heated and non-heated
versions of WMT700.
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FIX30 is not compatible with adapter cables due to the small diameter of the mast.

4.11.6.2.1 Adapter Cable for WS425 Serial Output

The Adapter Cable for WS425 Serial (227569SP) can be used with the WS425 cables
ZZ45203 and 010411.

The following table lists the adapter pin-outs and signal descriptions as they appear on their
user guides for both WMT700 and WS425 connectors.

Table 35 Pin-Outs for WS425 Serial Adapter Cable (227569SP)

WMT700
Connector Pin

WMT700 Signal
Description

WS425
Connector Pin

WS425 Signal
Description

WS425
Wire Color

1 Operating Power Supply 11 +12 VDC Brown

3 COM2: Rx-/ RS232RX 10 Data in (RxD) (R-) (RT-) Blue

4 COM2: Tx-/ RS232TX 9 Data out (TxD) (T‑) (RT-) Red

5 Heater Power Supply 16 +36 VDC Gray/Pink

7 Heater Power Supply Ground 3 GND Green

10 COM2: Communications
Ground

8 GND Yellow

11 Operating Power Supply
Ground

1 GND Black

14 COM2: Tx+ 12 Data out (T+) (RT+) White

15 COM2: Rx+ 14 Data in (R+) (RT+) Pink

The Adapter Cable for WS425 Serial (227569SP) does not support SDI-12 operation.

4.11.6.2.2 Adapter Cable for WS425 Analog Frequency Output

The Adapter Cable for WS425 Analog Frequency Output (227570SP) can be with the
WS425 cable ZZ45204. The following table lists the adapter pin-outs and signal
descriptions as they appear on their user guides for both WMT700 and WS425 connectors.
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Table 36 Pin-Outs for WS425 Analog Frequency Output Adapter Cable

WMT700
Connector Pin

WMT700 Signal
Description

WS425 Connector
Pin

WS425 Signal
Description

WS425
Wire Color

1 Operating Power
Supply

11 +12 VDC Brown

2 Analog Output AOUT2,
Wind Direction

13 WD Vout Gray

5 Heater Power Supply 16 +36 VDC Gray/Pink

7 Heater Power Supply
Ground

3 GND Green

11 Operating Power
Supply Ground

1 GND Black

12 Analog Output Ground 8 GND Yellow

13 Analog Output AOUT1,
Wind Speed

14 WS Fout Pink

17 Reference Input for
AOUT2

12 WD Vref in White

4.11.6.2.3 Adapter Cable for WS425 Analog Voltage Output

The Adapter Cable for WS425 Analog Voltage Output (227571SP) can be used with the
WS425 cable ZZ45204. The following table lists the adapter pin-outs and signal
descriptions as they appear on their user guides for both WMT700 and WS425 connectors.

Table 37 Pin-Outs for WS425 Analog Voltage Output Adapter Cable

WMT700
Connector Pin

WMT700 Signal
Description

WS425 Connector
Pin

WS425 Signal
Description

WS425 Wire
Color

1 Operating Power Supply 11 +12 VDC Brown

2 Analog Output AOUT2,
Wind Direction

13 WD Vout Gray

5 Heater Power Supply 16 +36 VDC Gray/Pink

7 Heater Power Supply
Ground

3 GND Green

11 Operating Power Supply
Ground

1 GND Black

12 Analog Output Ground 8 GND Yellow

13 Analog Output AOUT1,
Wind Speed

15 WS Vout Violet

17 Reference Input for
AOUT2

12 WD Vref in White

WMT700 User Guide M211095EN-H

96



4.11.6.3 WMT700 and WS425 Analog Output Signals

WMT700 pin connections differ from the connections of WS425 in that wind speed signal
output, both voltage and frequency signals, appears on WMT700 pin 13.

WMT700 analog outputs must be configured according to the appropriate analog output
mode, which is either voltage, frequency, or potentiometer.

Table 38 WMT700 and WS425 Analog Output Connections

WMT700
Connector Pin

WMT700 Signal
Description

Voltage Output WS425 Connector Pin, Wire Color

13 Analog Output AOUT1,
Wind Speed

Voltage 15, Violet (connect pin 14 to ground)

  Current not available

  Frequency 14, Pink

2 Analog Output AOUT2,
Wind Direction

Voltage 13, Gray

  Current not available

  Potentiometer 13, Gray

17 Reference Input for
AOUT2

Potentiometer 12, White

12 Analog Output Ground All modes 1, Black (common with supply
ground)

4.11.7 Powering in Retrofit Installations
WMT700 is designed to operate with the same supply voltages as WS425 and no
connection changes are necessary. The power consumption depends on the selected
heating options. WMT700 with heated transducers can be used to replace similar WS425
models. When upgrading from WS425 to WMT700 with heated transducers and arms, more
capacity is required from the power supply unit.

When WMT700 is in operation, the power consumption is higher than with WS425. This
can affect system performance in power-critical applications such as solar-powered or
battery-powered systems. Use solar-power or battery backup only to secure operating
voltage. Make sure that the solar-powered system has a sufficient power reserve available.
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5. Operation

5.1 Communicating with Terminal
Software

• PC with a serial port
• Required cables for a serial connection
• Any terminal software, such as Tera Term or Windows HyperTerminal

1. Connect a cable between your terminal computer, power supply, and WMT700.

2. Open the Windows HyperTerminal program.

3. Cancel the new connection.

4. Select File > Properties.

5. Select the correct COM port and Configure.

6. Set the communication parameters according to the configured port settings of
WMT700. WMT700 default values are: 

• Bits per second: 9600
• Data bits: 8
• Parity: None
• Stop bits: 1
• Flow control: None

7. Select Apply > OK.

8. Select Settings > ASCII Setup > ASCII sending - Send line ends with line feed > OK.
Click and close the New Connection Properties window.

9. Select View > Font and in the Font list, select Terminal.

10. Select Call > Call. Enter a name and select an icon for the connection. Select OK. 
When a serial line cable is connected to the PC and the terminal setup is correct, switch
the sensor power supply on. The following information is displayed to terminal screen:

       WMT700 v<version number>

The sensor goes to measurement mode after four seconds and it  is ready to receive
measurement mode commands.

Chapter 5 – Operation

99



11. At the end of each command, press ENTER to execute the command. For a successful
execution, the following combinations of Carriage Return <CR> and Line Feed <LF> are
accepted:<CR><LF><CR><LF>Communication baud rate can be configured from 300
baud to 115200 baud.

More Information

‣ Configuration Parameter Descriptions (page 187)

5.2 Entering and Exiting Configuration
Mode

With the OPEN and CLOSE commands you can toggle between configuration mode and
measurement mode. In the measurement mode, OPEN changes the mode to the
configuration mode, and in the configuration mode, CLOSE changes the mode to the
measurement mode. Note that the configuration mode does not recognize the OPEN
command and the measurement mode does not recognize the CLOSE command.

5.2.1 OPEN — Entering Configuration Mode
To switch WMT700 from the measurement mode to the configuration mode, use the OPEN
command.

$0OPEN<enter>

$ Fixed $ character starts the command.

0 Sensor address. All sensors answer 0 address.

OPEN The OPEN command

<enter> To activate the command, press ENTER.

After a successful OPEN command the sensor switches from measurement mode to
configuration mode and the following symbol is displayed:

>

If the port protocol is SDI-12, ("s comX_protocol,1"), use the command
0OPEN<ENTER> without the $ character.
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5.2.2 CLOSE — Exiting Configuration Mode
To switch WMT700 from the configuration mode to the measurement mode, use the CLOSE
command.

>CLOSE<enter>

> Configuration mode prompt

CLOSE The CLOSE command.

<enter> To activate the command, press ENTER.

5.3 Configuration

You have chosen the initial settings for WMT700 when placing the order. You can start
using WMT700 directly after the installation unless you want to check and/or change the
settings.

The initial settings have been configured at the factory according to your specifications
when ordering the product.

You can configure WMT700 settings for serial communication or analog output with
configuration commands using the serial port. Before starting configuration you must set
the port to the configuration mode. You can use one serial port in the configuration mode
while operating WMT700 from the other serial port.

WMT700 provides commands for:

• Parameter handling
• Wind measurement control
• Diagnostics
• Information

If the messages parameter is set to 1 (response for parameter setting is enabled, see D.
Configuration Parameter Descriptions (page 187)), WMT700 responds to an invalid
command with an error message.

If the messages parameter is set to 0 (response for parameter setting is disabled), WMT700
does not send any error messages. You can fetch the most recent error data in the
configuration mode with the ERRORS command.

You can configure WMT700 by sending individual commands or by loading a
configuration file to the sensor.
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Table 39 List of Configuration Mode Commands

Command Description

? Displays a list of configuration commands.

BAUD Changes or displays serial port settings.

CLEARERR Resets error counters.

CLOSE Switches the serial port to measurement mode.

ERRORS Fetches the error codes and counter information from WMT700.

G Displays either all or specified parameters.

H Displays a list of data messages and available values for measurement unit, profile, baud
rate, interface, and analog output mode.

MEAS Starts wind measurement based on the user-configurable averaging time. WMT700 does
not send data messages automatically.

POLL Tests data polling.

RESET Resets WMT700.

S Changes selected parameters or defines new data messages.

START Starts continuous measurement.

STOP Stops continuous measurement.

VERSION Displays the software version.

WIND_GET Fetches wind calibration information.

More Information

‣ ERRORS — Get Error Codes and Counts (page 106)
‣ Ordering Options (page 18)
‣ Restoring Serial Port Settings (page 170)

5.4 Parameter Handling Commands
All the commands in the configuration mode are in the following form:

>CMD x,y<enter>

> Configuration mode prompt

CMD Command

 Space

x Any parameter in Table 73 (page 187)
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, Comma

y Value of the parameter

<enter> Press ENTER to activate the command.

The parameter name and allowed parameter values depend on the command. For certain
commands they are optional. In the following command descriptions, WMT700
configuration mode prompt and enter are left out for clarity.

5.4.1 S — Set Parameter
The S command defines new data messages and changes values of the WMT700
parameters.

You can also use the S command to configure data messages.

If you try to set an invalid value for a parameter or an invalid item for a data message, the
response depends on the messages parameter. If messages are enabled (messages
parameter is set to 1), WMT700 responds with an error message. If the messages parameter
has been set to 0, WMT700 does not send any response to set parameter command. You
can also fetch the most recent error data in the configuration mode with the ERRORS
command.

Do not switch the power supply off immediately after the S command. Power must be on
for at least 5 seconds after the S command to save the updated parameters.

S x,y

x Any parameter in D. Configuration Parameter Descriptions (page 187).

y Value of the parameter

Example 1

In this example the baud rate is set to 2400 bps, parity to even, data bits to 8 bits, and stop
bits to 1 bit. WMT700 needs to be RESET before the communication settings take place.

S com1_baud,2 S com1_parity,1 S com1_data,8 S com1_stop,1

You can also change or view the serial port settings with the BAUD command. With the
BAUD command the communication settings take place immediately.
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Example 2

In this example the analog output 1 is set to send measurement data as a current signal, the
gain is set to 1 mA/m/s and the offset to 4 mA.
S aout1_o,0.004 S aout1_g,0.001 S aout1mode,0

Example 3

In this example both analog outputs are disabled to reduce power consumption.
S aout1mode,3 S aout2mode,7

More Information

‣ Configuration Parameter Descriptions (page 187)
‣ ERRORS — Get Error Codes and Counts (page 106)

5.4.2 G — Get Parameter
The G command shows the values of the configuration parameters. You can either display all
parameter values or only certain values.

More Information

‣ Configuration Parameter Descriptions (page 187)

5.4.2.1 Get All Parameters

You can use the G command to view all parameter values if you do not specify any
parameters in the command.

G

5.4.2.2 Get Specified Parameters

You can use the G command to view specified parameter values.

G x

x Any parameter in D. Configuration Parameter Descriptions (page 187).

Example

In this example the averaging time is shown to be 4 seconds:

G wndAvgs wndAvg ,3.00000
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5.4.3 BAUD — Display or Set Port Settings
This command shows or changes values of the serial port settings.

More Information

‣ Restoring Serial Port Settings (page 170)

5.4.3.1 Set Port Settings

You can use the BAUD command to change the bit rate, parity bit, data bits, stop bit, and
communication profile of the selected serial port.

There is a 100 ms delay after which WMT700 takes the settings into use. Do not send
commands to WMT700 during this time.

BAUD x,y,z,w 

x Bit rate (300, 1200, 2400, 4800, 9600, 19200, 38400, 57600, or 115200)

y Data bits (7 or 8)

z Parity (n = none, e = even, o = odd)

w Stop bits (1 or 2)

Example

The bit rate is set to 115200, data bits to 8, parity to none, and stop bits to 1:

BAUD 115200,8,n,1

5.4.3.2 Display Port Settings

You can use the BAUD command to display the current serial port settings.

BAUD
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5.5 Wind Measurement Control
Commands

5.5.1 MEAS — Single Wind Measurement
This command starts wind measurement based on the user-configurable averaging time.
WMT700 does not send the data message automatically. Use the polling command to fetch
measurement data in the required data message format.

MEAS

5.5.2 START — Start Continuous Measurement
This command starts continuous wind measurement. Continuous measurement starts when
you exit the configuration mode or restart WMT700.

You can retrieve data with a polling command or configure WMT700 to send data messages
at selected intervals. You can set the interval for automatic messages with the autoInt
parameter.

START

5.5.3 STOP — Stop Wind Measurement
This command stops continuous wind measurement.

To restart measurement, use the MEAS or START command. You can fetch the most recent
measurement data at any time with the polling command.

STOP

5.6 Diagnostics and Support Commands

5.6.1 ERRORS — Get Error Codes and Counts
This command fetches error information from WMT700.

ERRORS

The response:

WMT700 User Guide M211095EN-H

106



a,b,c,d,e,f

a Number of events since latest reset

b Code for the first event since latest reset

c Code for the most recent event

d Number of errors since latest reset

e Code for the first error since latest reset

f Code for the most recent error

Example

1,3,3,10,13,13
Interpretation of the example message:

• Number of events since latest reset: 1
• Code for the first event since latest reset: 3
• Code for the most recent event: 3
• Number of errors since latest reset: 10
• Code for the first error since latest reset: 13
• Code for the most recent error: 13

If no errors or events have occurred yet, the response is the following:

0,0,0,0,0,0

More Information

‣ Error and Event Messages (page 169)

5.6.2 CLEARERR — Reset Error Codes and Counts
This command resets the error counters of WMT700.

CLEARERR

5.6.3 POLL — Get Message
This command fetches the latest measurement data from WMT700. You need to specify the
data message format in the command.
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Vaisala recommends that you only use this command for testing data connections. To
fetch measurement data for other purposes, switch the serial port to the measurement
mode. The polling command in the measurement mode depends on the selected profile.

POLL y

y Identification number for the data message format.

More Information

‣ Data Messages (page 119)

5.6.4 RESET — Reset CPU
This command resets WMT700.

RESET

5.7 Information Commands

5.7.1 ? — Display Command Set
This command displays a list of available configuration commands.

?

5.7.2 H — Display Help and Messages
This command displays a list of supported data messages and their identification numbers
as well as the available values for wind speed measurement unit, profile, baud rate, interface,
and analog output.

H

5.7.3 VERSION — Show Firmware Version
This command displays the label and version of the WMT700 software.

WMT700 User Guide M211095EN-H

108



VERSION

5.7.4 WIND_GET — Get Calibration Data
This command fetches the WMT700 calibration date and other calibration data. This
information is mostly intended for Vaisala technical support.

WIND_GET

5.8 Configuration Parameters
A number of parameters affect WMT700 functionality.

To view and set parameter values, use the G and S commands.

You can configure WMT700 by sending individual commands or by loading a
configuration file to the sensor.

In the automatic message mode, to initiate continuous measurement, use the START
command.

More Information

‣ Configuration Parameter Descriptions (page 187)
‣ Upgrading from WS425 to WMT700 (page 88)
‣ Loading Settings from Configuration Files (page 115)
‣ START — Start Continuous Measurement (page 106)

5.9 Configurable Data Messages
You can define new data messages for automatic messaging or polling with the WMT700
profile. Each item in a user-configurable data message string consists of 2 characters after
the \ character. For example, the item for wind speed is \ws. The maximum number of
characters for a string is 80.

The characters are passed to messages as they are. All visible ASCII characters are allowed,
except the available items for data message strings listed in Table 40 (page 110).

Chapter 5 – Operation

109



You can only use the user-configurable data messages with the WMT700 protocol.

More Information

‣ Data Messages (page 119)

5.9.1 Configuring Data Messages
After you have defined the new data message, you can test the message by polling it in the
configuration mode. See 5.6.3 POLL — Get Message (page 107).

More Information

‣ POLL — Get Message (page 107)
‣ START — Start Continuous Measurement (page 106)

5.9.1.1 Items for Data Messages

The user-configurable data messages can contain wind measurement, control character,
check sum, and monitoring items. Configure new data messages with the msg1, msg2,
msg3, and msg4 parameters. All available items are listed in the following tables.

Table 40 Wind Measurement Items for Data Messages

Item Description

\ad Address

\dm Wind direction minimum calculated over the averaging period

\dx Wind direction maximum calculated over the averaging period

\gu Wind gust speed

\lu Wind lull speed

\rg Signal quality

\st Speed of sound

\ts Sonic temperature

\tz 10 s average of sonic temperature

\va Validity of the measurement data. The available values are:1 = Valid wind measurement
data0 = Unable to measure

\w1 Wind direction when the peak speed (\wp) occurred

\wd Wind direction, average

\wm Wind speed minimum calculated over the averaging period

\wp Wind speed maximum calculated over the averaging period
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Item Description

\ws Wind speed, average

\wx Wind speed average, x component

\wy Wind speed average, y component

Table 41 Control Character

Item Description

\01 SOH (start of heading)

\02 STX (start of text)

\03 ETX (end of text)

\04 EOT (end of transmission)

\cr CR (carriage return)

\lf LF (line feed)

\se Checksum calculation end point

\sp Print checksum

\ss Checksum calculation start point

Table 42 Monitoring Items for Data Messages

Item Description

\er Status code. The code is a decimal number. Each bit corresponds to a status flag. For a
list of the bits, see 5.9.2 Status Flags (page 113)

\fb 0 = No error

1 = Blocked sensor

\fh 0 = No error

1 = Heater failure. Incorrect heater resistance.

\fs 0 = No error

1 = Wind speed exceeds operating limits

2 = Sonic temperature exceeds operating limits

3 = Wind speed and sonic temperature exceed operating limits

\ft This value indicates temperature sensor failures when converted to binary format:

Bit 0 = Temperature sensor 1 failure

Bit 1 = Temperature sensor 2 failure

Bit 2 = Temperature sensor 3 failure
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Item Description

\fv 0 = No error

1 = Supply voltage (Vh or Vi) too high

2 = Supply voltage (Vh or Vi) too low

\pa Average heating power

\ra Heater resistance

\ta Transducer temperature

\ti Internal temperature

\vh Heater voltage

\vi Supply voltage

Example

In this example a new data message with identification number 1 is defined. The items
included in the message are average wind speed, average wind direction, and supply
voltage. S msg1,$\ws,\wd,\vi\cr\lf
When the above message is polled, WMT700 sends the following data if the average
wind speed is 5 m/s, the average wind direction is 128 degrees, and the supply voltage is
23.4: $05.00,128,23.4<CR><LF>
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Example

In this example the data message 2 is set to include the following items:

• SOH
• Checksum calculation start point
• Wind speed, average
• Wind direction, average
• Wind gust speed
• Wind lull speed
• Wind direction minimum
• Wind direction maximum
• Wind direction during the peak speed (wp) occurred
• Checksum calculation end point
• EOT
• Print checksum
• CR
• LF
S msg2,\01\ss$\ws,\wd,\gu,\lu,\dm,\dx,\w1\se\04\sp\cr\lf

WMT700 sends the following message that starts with the SOH character which is
excluded from the checksum. The checksum ends before the EOT character. The
checksum (in this case, D8) is printed after the EOT character.

┌_$02.66,98.21,02.66,02.60,95.68,99.53,99.34_D8<CR><LF>
The non-printable characters are shown above as ┌ ┘and <CR><LF>.

5.9.2 Status Flags
The following list describes the status flags included in the data message when the status
code item \er has been added to the message. Each bit corresponds to a specific status.

Status flags are coded in decimal number format. To extract each bit from the status code,
the decimal number must be converted to binary format.

Table 43 Status

Bit Description

0 Temperature sensor 1 failure

1 Temperature sensor 2 failure

2 Temperature sensor 3 failure

3 Heater failure. Incorrect heater element resistance

4 Too high (Vh > 40 V or Vi > 40 V) supply voltage

5 Too low (Vh < 20 V or Vi < 10 V) supply voltage
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Bit Description

6 Wind speed exceeds operating limits.

7 Sonic temperature exceeds operating limits.

8 Wind measurement fails over 80% of the averaging time. Reported wind is still correct.

9 Not used

10 Blocked sensor. Reported wind is still correct.

11 High noise level

12 Message received correctly. The value is always 1.

The status flags are set when an event is detected. The flags are cleared when a status
message is reported. To get the current situation, you must read the status message twice.
The first status message shows all events since the last read. The second status message
shows the current situation.

Example
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5.9.3 Loading Settings from Configuration Files
You can configure configuration of WMT700 settings over the RS-485, RS-422, or RS-232
interface using configuration files. You can send a text file containing the configuration
settings to the sensor with a terminal program, such as Tera Term or Windows
HyperTerminal.

1. Use the G command to fetch the current WMT700 parameters.

2. Disable error messages with the command S messages,0
3. Copy the values from the terminal program to a file. Remove the parameters you do not

want to change. Also remove the parameter “messages” to avoid switching messaging
on during the transfer.

4. Clear the error counters with the command CLEARERR.

5. Send the file to WMT700 to change the settings.
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6. To verify that the parameters are set correctly (the values are in the allowed range and
all parameters are valid), read the error counters with the command ERRORS. 
If all values are valid, WMT700 sends the following response:

0,0,0,0

You can also use the G command to check that the parameters are set correctly.
If the response for parameter setting is not disabled (as instructed in step 3) but the
messages parameter is set to 1 instead, WMT700 responds to each S command
confirming the new parameter values. If an error occurs during the configuration,
WMT700 sends a response containing the error messages.

RS-485 is a half-duplex interface. If the RS-485 interface is used and response for
parameter setting is enabled (messages parameter is set to 1), a simple terminal
program cannot be used for loading parameters from file.

This configuration file contains all the WMT700 parameters that are user-configurable.
For example:

S wndAvg,1.00000
S wndUnit,0
S wndDirOffset, 0.00000
S wndOrientation,0
S wndGustTime,3.00000
S wndCover,4
S wndVector,1
S wndCoast,0.00000
S autoInt,1.00000
S autoSend,0
S autoPort,1
S com1_baud,4
S com1_parity,0
S com1_data,8
S com1_stop,1
S com1_protocol,0
S com1_delay,20
S com2_baud,4
S com2_parity,0
S com2_data,8
S com2_stop,1
S com2_protocol,0
S com2_delay,20
S com2_interf,0
S sleepTime,5
S startDelay,5
S heaterOn,1.00000 
S freqType,0
S aout1_o,0.00000
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S aout1_g,1.00000
S aout1minv,0.00000
S aout1maxv,32000.0
S aout1err,1000.00
S aout1mode,3
S aout2_g,1.00000
S aout2_o,0.00000
S aout2minv,0.00000
S aout2maxv,32000.0
S aout2err,1000.00
S aout2mode,7
S msg1,\ss$\ws,\wd,\se\sp\cr\lf
S msg2,2
S msg3,3
S msg4,4
S address,A
S messages,1

More Information

‣ Configuration Parameter Descriptions (page 187)

5.10 Operating WMT700
When WMT700 is installed and configured, you can start operating the wind sensor:

• To receive wind measurement data through a serial connection as data messages, use
serial communication.

• If you use the WMT700 profile, see the following operating instructions.
• If you use WS425 or SDI-12 profiles, see 5.17 Operating WMT700 with WS425 and

SDI-12 Profiles (page 133)
• To receive wind measurement data as current, potentiometer, voltage, or frequency

output, use analog output.

For a complete list of the serial commands available for the WMT700 series wind sensors,
see A. Command Set for WMT700 (page 181).

More Information

‣ Analog Output (page 43)
‣ Operating WMT700 in WS425 Analog Output Mode (page 128)
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5.10.1 Operating WMT700 with Terminal Program

• PC with a serial port.
• Required cables for serial connection. See 2.4.3 Cables (page 28).
• Any terminal program, such as Tera Term or Windows HyperTerminal.

1. Connect a cable between your terminal computer, power supply, and WMT700.

2. Open the Windows HyperTerminal program.

3. Cancel the new connection.

4. Select File > Properties.

5. Select the correct COM port and select Configure.

6. Set the communication parameters according to the configured port settings of
WMT700. The default values for WMT700 are:

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None

7. Select Apply > OK.

8. Select Settings > ASCII setup > ASCII sending - Send line ends with line feed 
(optional) > OK. Close the New Connection Properties window.

9. Select View > Font > Terminal.

10. Select Call > Call. Enter a name and select an icon for the connection. Select OK.

11. Switch the sensor power supply on. The following information is displayed: WMT700
v<version number>

12. Wait for 4 seconds. WMT700 enters measurement mode automatically.

13. To test the connection, enter configuration mode with the following command:
$0OPEN<CR><LF>

14. Use the following command to return to measurement mode: CLOSE<CR><LF>
You can now start operating WMT700. Note that WMT700 does not send data messages
automatically unless configured to do so.

More Information

‣ Measurement Mode Commands (page 125)
‣ Communicating with Terminal Software (page 99)
‣ Data Messages (page 119)
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5.10.2 Data Messages
The data messages can contain measurement data calculated by WMT700 and information
on the status and properties of the wind sensor.

For the automatic message mode, you must set the following parameters:

• autoInt (defines the message send interval in seconds, 0.25 s resolution)
• autoSend (0 = automatic message mode disabled, for available messages, see the

following table.
• autoPort (defines where the message is sent: 1 = COM1, 2 = COM2)

When the WMT700 protocol is used, you can use either one of the predefined message
formats or user-configurable data message format.

The following table lists the data messages supported by WMT700. You need the data
message numbers when you use the WMT700 protocol POLL command or the automatic
message mode with any protocol.

Table 44 Data Messages

Data Message Number Description

WMT700 Data Messages

20 WMT700 NMEA MWV profile message that reports average wind speed and
direction.

21 WMT700 profile message that reports average wind speed and direction.

22 WMT700 profile message that reports wind speed in x and y components.

23 WMT700 profile message that reports wind speed and direction and self-
diagnostics information.

24 WMT700 profile message that reports wind speed and direction and self-
diagnostics information, and includes the checksum.

25 WMT700 profile message that reports wind measurement, sonic temperature, and
status data, and includes the checksum.

27 ROSA - MES12 Standard profile message

WS425 and SDI-12 Messages

15 WS425 A/B NMEA Extended profile message

16 WS425 A/B ASCII profile message

17 WS425 A/B SDI-12 profile message for M command

18 WS425 A/B SDI-12 profile message for V command

19 WS425 A/B NMEA Standard profile message

32 WS425 A/B WAT11 profile message

User-Configurable Data Messages
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Data Message Number Description

1 Items defined by the user.

2

3

4

To select a data message when using polling, specify the corresponding data message
identification number in the polling command.

To select a data message when using automatic messages, use the configuration
parameters.

More Information

‣ Configuration Parameters (page 109)
‣ POLL — Poll Data (page 127)

5.10.2.1 WMT700 Data Message 21

WMT700 Data Message 21 reports the wind speed and direction in the following format:

$\ws,\wd\cr\lf

$ Fixed text

\ws Wind speed, average

\wd Wind direction, average

\cr CR (carriage return)

\lf LF (line feed)

Example

$00.08,299.20<cr><lf>
• Wind speed, average: 0.08 m/s
• Wind direction, average: 299.2°

5.10.2.2 WMT700 Data Message 22

WMT700 Data Message 22 reports the wind speed in x and y components in the format
described below:
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$\wx,\wy\cr\lf

$ Fixed text

\wx Wind speed average, x component

\wy Wind speed average, y component

\cr CR (carriage return)

\lf LF (line feed)

Example
$-00.04,00.07<cr><lf>

Interpretation of the example message:

• Wind speed, average, x component: -0.04
• Wind speed, average, y component: 0.07

5.10.2.3 WMT700 Data Message 23

WMT700 Data Message 23 reports wind measurement and self-diagnostics data in the
following format:

$\ws,\wd,\wp,\wm,\Ts,\vh,\vi,\ta,\er\cr\lf

$ Fixed text

\ws Wind speed, average

\wd Wind direction, average

\wp Wind speed, maximum

\wm Wind speed, minimum

\Ts Sonic temperature

\vh Heater voltage

\vi Supply voltage

\ta Transducer temperature

\er Status code. The code is a decimal number. Each bit corresponds to a status flag. See 5.9.2
Status Flags (page 113).

\cr CR (carriage return)
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\lf LF (line feed)

$03.21,75.83,03.34,03.15,22.37,12.2,23.5,20.0,32<cr><lf>

5.10.2.4 WMT700 Data Message 24

WMT700 Data Message 24 reports wind measurement and self-diagnostics data. The
checksum is included in the message. WMT700 calculates the checksum by applying 8‑bit
XOR for all bytes between checksum calculation start point and end point. The result is
printed as a 2‑digit hexadecimal value.

\ss$\ws,\wd,\wp,\wm,\Ts,\vh,\vi,\ta,\er,\se\sp\cr\lf

\ss Checksum calculation start point, not shown in the message

$ Fixed text

\ws Wind speed, average

\wd Wind direction, average

\wp Wind speed, maximum

\wm Wind speed, minimum

\Ts Sonic temperature

\vh Heater voltage

\vi Supply voltage

\ta Transducer temperature

\er Status code. The code is a decimal number. Each bit corresponds to a status flag.

\se Checksum calculation end point, not shown in the message

\sp Print checksum (to verify message integrity)

Example of WMT700 Data Message 24

$03.45,76.03,03.58,03.37,21.97,23.8,23.6,23.8,0,0B<cr><lf>

Interpretation :

• Wind speed, average: 3.45 m/s
• Wind direction, average: 76.03°
• Wind speed, maximum: 3.58 m/s
• Wind speed, minimum: 3.37 m/s
• Sonic temperature: 21.97 °C
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• Heater voltage: 23.8 V
• Supply voltage: 23.6 V
• Transducer temperature: 23.8 °C
• Status code: 0
• Checksum: D4

More Information

‣ Status Flags (page 113)

5.10.2.5 WMT700 Data Message 25

WMT700 Data Message 25 reports wind measurement, sonic temperature, and status data.
The checksum is included in the message. WMT700 calculates the checksum by applying 8-
bit XOR for all bytes between checksum calculation start point and end point. The result is
printed as a 2-digit hexadecimal value. The message is in the following format:

\ss$\ws,\wd,\wp,\wm,\Ts,\er,\se\sp\cr\lf

\ss Checksum calculation start point, not shown in the message

$ Fixed text

\ws Wind speed, average

\wd Wind direction, average

\wp Wind speed, maximum

\wm Wind speed, minimum

\Ts Sonic temperature

\er Status code. The code is a decimal number. Each bit corresponds to a status flag. See
5.9.2 Status Flags (page 113).

\se Checksum calculation end point, not shown in the message

\sp Print checksum (to verify message integrity)

\cr CR (carriage return)

\lf LF (line feed)
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Example

$03.22,75.29,03.38,03.07,22.13,0,3E<cr><lf>
Interpretation of the example message:

• Wind speed, average: 3.22 m/s
• Wind direction, average: 75.29°
• Wind speed, maximum: 3.38 m/s
• Wind speed, minimum: 3.07 m/s
• Sonic temperature: 22.13 °C
• Status code: 0
• Checksum: A4

5.10.2.6 ROSA - MES12 Data Message

The MES12 data message 12 is used in the ROSA Surface Analyzer for Roads and Runways
system. You can use this data message when WMT700 is connected to the Vaisala ROSA
system.

This message contains sensor identifications (sids), corresponding data items, and the
synchronization characters SOH, STX, and ETX. The lines are ended by CR and LF characters.

5.10.3 Missing Readings
If WMT700 is not able to measure the wind, it indicates a missing reading in the output. The
most common reasons for measurement problems are ice, birds, or other foreign objects on
the line of measurement.

When the WMT700 profile is used, WMT700 indicates missing readings by showing 999 in
the data messages.

When the WMT700 Data Message 22 is polled, missing readings are indicated with the
following response:

$999.00,999.00<cr><lf>

5.10.4 Error Indication
WMT700 provides advanced self-diagnostics for monitoring the status of the wind sensor
and the validity of the measurement data. You can use the diagnostics as follows:
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• WMT700 checks the status of the internal operational software at each reset by
verifying the CRC checksum of the software. The software check is not made
periodically; it is only made at each reset. If the checksum is incorrect, WMT700 does
not start up. If the checksum is correct, WMT700 continues by calculating the CRC
checksum of the parameter memory. In case the parameter memory is corrupted, the
sensor replies with the text Parameters crc error upon startup. In case the
parameter memory checksum is correct, WMT700 replies with the text ready as
shown in the example below.

>$WMT700 v<version number>
ready.

• To check the status of the wind sensor, include the status code item \er in the data
message. You need to convert the status code to a binary number to verify the status.
An error code does not indicate that the wind data is invalid.

• To check that the wind data is valid, include the \va item in the data message.
• To check other diagnostics-related data, include the required items in the data

message.

More Information

‣ Status Flags (page 113)
‣ Items for Data Messages (page 110)
‣ Command Set for WMT700 (page 181)

5.11 Measurement Mode Commands
The available commands in the measurement mode depend on the selected profile.

For a list of serial commands available for all the communication profiles supported by
WMT700, see A. Command Set for WMT700 (page 181).

More Information

‣ Command Set for WMT700 (page 181)
‣ Operating WMT700 with WS425 and SDI-12 Profiles (page 133)

5.11.1 WMT700 Profile Commands
When you select the WMT700 profile, you can operate WMT700 with these commands. In
the command descriptions, <CR> is an ASCII carriage return control character and <LF> is
an ASCII line feed control character. You can send commands at any speed. The command is
executed when end-of-line character is received.
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Each measurement mode command must start with the user-configurable WMT700
address. It can be any string of printable ASCII characters with the maximum length of 30
characters. Characters <CR>, <LF>, and $ are not allowed. If you use 0 as the address in the
command, WMT700 responds regardless of the configured address.

If you have enabled response for parameter setting (messages parameter is set to 1),
WMT700 responds to an invalid command with an error message.

Table 45 Measurement Mode Commands

Command Description

$aMEAS Starts wind measurement in single measurement mode. The duration of the
measurement is based on the user-configurable averaging time.

$aOPEN Switches the serial port to configuration mode.

$aPOLL,y Fetches latest measurement data from WMT700.

$aSLEEP Switches WMT700 from normal operating mode to low-power mode.

$ Fixed text

a WMT700 address. If the value is 0, it refers to any WMT700 address.

y Identification number for the data message format.

5.11.1.1 MEAS — Start Measurement

This command starts wind measurement in single measurement mode based on the user-
configurable averaging time. WMT700 does not send the data message automatically. Use
the polling command to fetch the measurement data in the required format.

$aMEAS<CR><LF>

$ Fixed text

a WMT700 address. If the value is 0, it refers to any WMT700 address

5.11.1.2 OPEN — Enter Configuration Mode

This command switches the serial port to the configuration mode.

$aOPEN<CR><LF>

$ Fixed text
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a WMT700 address. If the value is 0, it refers to any WMT700 address

WMT700 automatically returns to normal operating mode, if it does not receive
commands in two minutes, or if it detects multiple unrecognized commands.

5.11.1.3 POLL — Poll Data

This command fetches data from WMT700. You need to specify the data message number in
the polling command.

When WMT700 is in the low-power mode, it does not receive the first character in the
command. You must send an extra character (space) before the polling command to
receive data.

$aPOLL,y<CR><LF>

$ Fixed text

a WMT700 address. If the value is 0, it refers to any WMT700 address.

y Identification number for the data message format.

Example

In this example WMT700 custom data message 1 is polled from WMT700.

$0POLL,1<CR><LF>

More Information

‣ Data Messages (page 119)

5.11.1.4 SLEEP — Enter Low-Power Mode

This command switches WMT700 from the normal operating mode to the low-power mode.
WMT700 resumes normal operation after sleep period determined by the sleepTime
parameter has elapsed, or when a character is received on data port COM2. For more
information on the sleepTime parameter.

$aSLEEP<CR><LF>
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$ Fixed text

a WMT700 address. If the value is 0, it refers to any WMT700 address.

More Information

‣ Configuration Parameters (page 109)

5.11.2 ROSA - MES12 Profile Commands
When the ROSA - MES12 profile is selected, you can poll data in the MES12 data message
format. This data message is used in the ROSA Surface Analyzer for Roads and Runways
system. You can use this data message when WMT700 is connected to the Vaisala ROSA
system.

5.11.2.1 M 12 — Poll MES12 Data Message

This command fetches data from WMT700 in the MES12 data message format.

@a M 12<CR><LF>

@ Fixed text

a WMT700 address. The allowed range is from 0 to 99.

More Information

‣ ROSA - MES12 Data Message (page 124)

5.12 Operating WMT700 in WS425
Analog Output Mode

5.12.1 Analog Output Settings
In analog output operation WMT700 takes measurements according to the configured
averaging time and synthesizes the analog outputs of wind speed and wind direction with
an update interval of 0.25 seconds. The analog output signal type and range depend on the
configured settings.

Normally, analog output is enabled and the output settings are preconfigured at the factory
according to your order. WMT700 can be operated using these settings directly after the
installation. However, the analog output settings of WMT700 can be changed or the analog
output functionality can be disabled at any time to save power over the serial interface.

When operating WMT700 in a system configured for WS425, you must configure the analog
output settings according to the following table using the S command.

WMT700 User Guide M211095EN-H

128



Table 46 Required Parameters for WS425 Analog Output Operation Mode

Parameter
Name

Default Value Allowed Values Description of How to Emulate WS425

aout1err 1000 0 …. 32000 Set 1 for voltage output and 625 for frequency
output for similar operation as with WS425.

aout1_g 1 0 …. 100 Gain for AOUT1. Set 0.017895 for compatibility
with WS425 voltage output. Set 11.18 for
compatibility with WS425 frequency output.

aout2_g 1 0 …. 100 Gain for AOUT2. Set 0.0027855 for compatibility
with WS425 potentiometer output.

aout1mode 3 0 = Current

1 = Voltage

2 = Frequency

3 = Disabled

Analog output mode for AOUT1. Set 1 for WS425
voltage output compatibility. 2 for WS425
frequency output compatibility.

aout2mode 7 4 = Current

5 = Voltage

6 = Potentiometer

7 = Disabled

Analog output mode for AOUT2.Set 6 WS425
potentiometer output compatibility.

aout1_oaou
t2_o

0 -10000 … 10000 Offset for AOUT1 and AOUT2.Set output offset to
0.

More Information

‣ S — Set Parameter (page 103)

5.13 Wind Speed Output
In a system configured for WS425, you can set WMT700 to measure wind speed and send
analog output as frequency or voltage.

These sections describe WMT700 analog output:

• Settings are configured according to 5.12.1 Analog Output Settings (page 128).
• Wires are connected according to 4.11.6.1.1 ROSA Cable 10 m (Analog Outputs)

(page 93).

5.13.1 Frequency
When frequency is selected as the wind speed analog output, WMT700 sends a pulsed
signal of 0 to 10 V with a frequency proportional to wind speed through AOUT1. Every mile
per hour adds 5 Hz (WS425) to the frequency. In SI units, a change of 0.894 meters per
second adds 10 Hz to the frequency. A frequency counter is required to count the output in
Hz and the calculation that scales the result to appropriate units.

The following figure shows the frequency output when an adapter cable for analog
frequency output (227570SP) and a WS425 cable are used. With WMT700, the wind speed
signal appears at pin 14 (pink) of the adaptor cable.
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Figure 43 Wind Speed Frequency Analog Output with WS425 Cable and Adapter Cable for
Analog Frequency Output

5.13.2 Voltage
When voltage is selected as the wind speed analog output, the output from WMT700 varies
linearly from 0 VDC at 0 miles per hour to 1 VDC at 125 miles per hour. In SI units, the voltage
varies linearly from 0 VDC at 0 meters per second to 1 VDC at 55.88 meters per second.

The following figure shows the voltage output when an adapter cable for voltage output
(227571SP) and a WS425 cable are used. With WMT700, the wind speed signal appears at
pin 15 (violet) of the adaptor cable. The violet wire must be connected to V read channel,
and the pink wire must be connected to the analog ground.
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Figure 44 Wind Speed Voltage Analog Output with WS425 Cable and Adapter Cable for
Analog Voltage Output

5.14 Wind Direction Output
When wind direction is measured, WMT700 sends analog output as simulated
potentiometer output voltage referred to as external reference voltage. The output is a
proportional signal 0 ... 100 % of the reference voltage representing the wind direction. The
reference voltage must be in the range of 1.0 ... 4.0 VDC (WMS425) or 0 … 10 VDC
(WMT700). The output is 0 VDC at zero degrees and increases to the reference voltage at
359 degrees.

The following figure shows the output for wind direction. With WMT700, the wind direction
signal appears at pin 13 (gray) of the adapter cable.

Chapter 5 – Operation

131



Figure 45 Wind Direction Voltage Output with WS425 Cable and Adapter Cable

5.15 Limitations for Output Signals
You can specify the minimum and maximum values for analog output with the configuration
parameters. The output is fixed to the specified values, and the unit depends on the selected
analog output mode.

Example

To limit the output 1 in voltage mode to a range of 0.1 … 5 V, set the analog output
minimum value to 0.1 and the analog output maximum value to 5. Type the following
commands:

S aout1minv,0.1 S aout1maxv,5

5.16 Missing Readings and Error
Indication

If WMT700 is unable to measure the wind, it indicates a missing reading in the output. The
most common reasons for measurement problems are foreign objects (such as ice, birds, or
other foreign object) on the line of measurement or sound reflections from nearby objects
(such as wind tunnel walls).
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The default error indication is an out-of-range signal that is more than 10 V or 20 mA but
other error settings can also be configured.

Example

To set analog output 1 error indication in voltage mode to 1 V, set the analog output error
value to 1. Use the following command:

S aout1err,1

More Information

‣ Configuration Parameter Descriptions (page 187)

5.17 Operating WMT700 with WS425 and
SDI-12 Profiles

Each communication profile has its own section listing the configurable parameters and the
available commands and data messages.

5.18 Communication Profiles
WMT700 supports the following communication profiles:

• WMT700
• ROSA - MES12
• WS425 - ASCII
• WS425 - NMEA Extended (version 0183)
• WS425 - SDI-12 (version 1.3)
• WS425 - ASOS

The profile has been preconfigured at the factory according to your requirements specified
when ordering WMT700. You can change the profile through the serial interface, if
necessary.

5.18.1 Changing Communication Profile
The communication profile and other settings have been configured at the factory
according your specifications. You can start using WMT700 directly after the installation
with these settings.

If you want to change the communication profile, you must change all parameters to match
the new profile.
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5.19 Operating WMT700 with Terminal
Program

• PC with a serial port.
• Required cables for serial connection. See 2.4.3 Cables (page 28).
• Any terminal program, such as Tera Term or Windows HyperTerminal.

1. Connect a cable between your terminal computer, power supply, and WMT700.

2. Open the Windows HyperTerminal program.

3. Cancel the new connection.

4. Select File > Properties.

5. Select the correct COM port and select Configure.

6. Set the communication parameters according to the configured port settings of
WMT700. The default values for WMT700 are:

Bits per second 9600

Data bits 8

Parity None

Stop bits 1

Flow control None

7. Select Apply > OK.

8. Select Settings > ASCII setup > ASCII sending - Send line ends with line feed 
(optional) > OK. Close the New Connection Properties window.

9. Select View > Font > Terminal.

10. Select Call > Call. Enter a name and select an icon for the connection. Select OK.

11. Switch the sensor power supply on. The following information is displayed: WMT700
v<version number>

12. Wait for 4 seconds. WMT700 enters measurement mode automatically.

13. To test the connection, enter configuration mode with the following command:
$0OPEN<CR><LF>

14. Use the following command to return to measurement mode: CLOSE<CR><LF>
You can now start operating WMT700. Note that WMT700 does not send data messages
automatically unless configured to do so.
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More Information

‣ Measurement Mode Commands (page 125)
‣ Communicating with Terminal Software (page 99)
‣ Data Messages (page 119)

5.20 Entering Configuration Mode
This command switches the serial port to configuration mode. The command works with any
communication profile supported by WMT700.

$aOPEN<CR><LF>

$ Fixed text

a Value of the address parameter. If the value is 0, it refers to any WMT700 address

<CR> Carriage return

<LF> Line feed

5.21 F/G ASOS Profile
The following table lists the configurable parameters and their allowed and default values
for the WS425 F/G ASOS profile.

Table 47 Configurable Parameters for WS425 F/G ASOS Profile

Parameter Default
Value

Profile-Specific Allowed Values Description

autoSend 0 0 = Automatic messages disabled Automatic data message number.
Selects the data message format
for automatic messages

com1_protocol 0 1) 2 = WS425 F/G ASOS Profile for serial port COM1

com2_protocol 2 2 = WS425 F/G ASOS Profile for serial port COM2

com2_interf N/A 2) 0 = RS-485

1 = RS-422

3 = RS-232

Interface for serial port COM2

wndAvg 5 0.25 … 3600

Resolution: 0.25

Averaging time for wind
measurement in seconds

wndGustTime 3 0.25 … 3600

Resolution: 0.25

Averaging time for wind minimum
and maximum in seconds
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Parameter Default
Value

Profile-Specific Allowed Values Description

wndOrientation 0 0 = Array facing up

1 = Array facing down

Orientation of the array of WMT700

wndUnit 0 2) 0 = Meters per second (m/s)

1 = Miles per hour (mph)

2 = Kilometers per hour (km/h)

3 = Knots (knot)

Wind speed unit

wndVector 0 0 = Scalar averaging Wind averaging method

1) The parameter has no protocol-specific default value. It is determined separately in the configuration code.
2) Wind speed unit and COM2 digital communication interface are defined in the order form. Default setting may be any of the

allowed options, and it can be verified from the unit’s configuration code.

To start continuous measurement, use the START command.

To stop measurement, use the STOP command.

5.21.1 WS425 F/G ASOS Commands
WMT700 responds to each command with a fixed-length message. In the command
descriptions, <CR> is an ASCII carriage return control character and <LF> is an ASCII line
feed control character.

When the WS425 F/G ASOS profile is selected, WMT700 only responds to upper case
characters.

The following commands are available for operating WMT700 with the WS425 F/G ASOS
profile.

Table 48 WS425 F/G ASOS Commands

Command Description

WA Requests average wind speed and direction message.

WS Requests the verbose built-in test (BIT) results.

WT Requests the short response BIT results and status.

WD Reports the BIT status.

WF Returns a fixed pattern of data

The WA command is executed by the ASOS at an interval that ranges from 1 to 30 seconds.
For the WA command, WMT700 responds to the ASOS interrogation poll within 250
milliseconds of receiving the request.
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The following WS425 F/G ASOS commands cannot be used with WMT700: WB,
WFIRMWARE, WJ, WR, WCAL, WH, WCDV, WSTK, WL, WM, WN, WSST, and WATE. You can only
configure WMT700 in the configuration mode. For a list of configuration commands for
WMT700, see 5.3 Configuration (page 101).

5.21.1.1 WA — Fetch Averaged Wind Speed and Direction

This command requests the averaged wind speed and direction message with peak winds.

WA <CR><LF>

The response to the WA command consists of the averaged wind speed and direction data,
peak wind speed, and associated direction. The average wind speed is a scalar running
average of the fundamental 1-second interval wind speed measurement made by WMT700.

You can set the wind averaging time and gust time with the wndAvg and wndGustTime
parameters. Set the wndVector parameter to 0 to use scalar averaging.

The command also fetches the WMT700 status, the averaging time for average and peak
wind speed and wind direction, and signal quality.

More Information

‣ WS425 F/G ASOS Data Message (page 140)

5.21.1.2 WS — Fetch Internal Diagnostics Information

This command requests the verbose Built-In Test (BIT) results.

WS<CR><LF>

The command gives a textual run down of the results of all Built-In Tests (BITs). In every line,
except the bad reading counter, the pass/fail indication is given with the single character P
or F. This is followed by the description of the measured parameter, which is followed by the
actual measured value.

The Bad 1 second readings counter is a running total of the number of fundamental 1-second
readings that the sensor flagged as bad. This number rolls over to zero after reaching the
count value of 65535. It is initialized to zero on each power-up or any other activity that
performs a re-initialization of the sensor. The time measurement quality indices are given for
path numbers as follows:

• Path 0 is from south transducer to north transducer
• Path 1 is from north transducer to south transducer
• Path 2 is from north transducer to east transducer
• Path 3 is from east transducer to north transducer
• Path 4 is from east transducer to south transducer
• Path 5 is from south transducer to east transducer
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A listing for the command response is given below with representative values.

<CR><LF>
P Heater voltage 22.3 Volts <CR><LF>
P Array heater resistance 4.9 Ohms <CR><LF>
P Heaters off voltage 0.1 Volts <CR><LF>
P Incoming supply voltage 12.2 Volts <CR><LF>
P 5.0 volt supply 5.05 Volts <CR><LF>
P 10 volt supply 10.2 Volts <CR><LF>
- Bad 1 second reading counter 0 <CR><LF>
P Path 0 signal quality index 99 <CR><LF>
P Path 1 signal quality index 99 <CR><LF>
P Path 2 signal quality index 99 <CR><LF>
P Path 3 signal quality index 99 <CR><LF>
P Path 4 signal quality index 99 <CR><LF>
P Path 5 signal quality index 99 <CR><LF>

The test limits for the various tests are as listed below:

• Heater voltage good in range 18.0 to 26.0 V
• Array heater resistance good in range 4.0 to 6.0 Ω
• Heaters off voltage good if below 0.5 V
• Incoming supply voltage good in range 10.5 to 13.5 V
• 5.0 V supply good in range 4.5 to 5.5 V
• 10 V supply good in range 9.0 to 11.0 V
• Signal Quality Index good above 50

5.21.1.3 WT - Request Short Response BIT Results and Status

The command WT requests the short response built-in test (BIT) results and status. The
command format:

WT CR LF

The response:

Byte 1 STX start of text ASCII control character

Byte 2 W sensor ID

Byte 3 T command identifier

Byte 4 P or F for heater voltage pass or fail

Byte 5-8 XX.X format heater voltage (volts RMS)

Byte 9 P or F for array heater resistance pass or fail

Byte 10-12 X.X or XX. (format as required) for array heater resistance (ohms)

Byte 13 P or F for pass or fail on heater off voltage
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Byte 14-16 X.X format heater off voltage (volts RMS)

Byte 17 P or F for pass or fail thermistor temperature

Bytes 18-20 Thermistor temperature (degrees Celsius)

Byte 21 P or F for incoming supply voltage pass or fail

Byte 22-25 XX.X format incoming supply voltage (volts DC)

Byte 26 P or F for 5 volt supply pass or fail

Bytes 26-29 X.XX format 5 volt supply voltage (volts DC)

Byte 30 P or F for 10 volt supply pass or fail

Bytes 31-34 XX.X format 10 volt supply voltage (volts DC)

Byte 35 ASCII hyphen character (-)

Bytes 36-40 XXXXX format bad 1 second reading counter

Byte 41 P or F for path 0 Signal Quality Index pass or fail

Bytes 42-43 XX format path 0 Signal Quality Index

Byte 44 P or F for path 1 Signal Quality Index pass or fail

Bytes 45-46 XX format path 1 Signal Quality Index

Byte 47 P or F for path 2 Signal Quality Index pass or fail

Bytes 48-49 XX format path 2 Signal Quality Index

Byte 50 P or F for path 3 Signal Quality Index pass or fail

Bytes 51-52 XX format path 3 Signal Quality Index

Byte 53 P or F for path 4 Signal Quality Index pass or fail

Bytes 54-55 XX format path 4 Signal Quality Index

Byte 56 P or F for path 5 Signal Quality Index pass or fail

Bytes 57-58 XX format path 5 Signal Quality Index

Bytes 59-60 XX hexadecimal ASCII for modulo 256 checksum for Character positions 2 through 58

Byte 61 ETX end of text ASCII control character

Byte 62 ASCII carriage return control character

Byte 63 ASCII line feed control character

5.21.1.4 WD - Report Status of Built-in Tests

The command WD reports the status of the built-in tests (BIT). The command offers a
concise report on the pass/fail status of all BITs. The command format is:

WD CR LF

The response:
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STX WD PPPPPPPPPPPP CS ETX CR LF

STX ASCII start of test control character (position 1)

WD Command identifier (positions 2,3)

P or F Pass/Fail for 12 built in tests specified in WS command above in the order shown in the
WS command text (positions 4-15) except Thermistor temperature.

CS Modulo 256 hexadecimal checksum of all characters from position 2 through the last P
or F (positions 16,17)

EXT ASCII end of text control character (position 18)

CR ASCII carriage return control character (position 19)

LF ASCII line feed control character (position 20)

5.21.1.5 WF - Return Fixed Pattern of Data

The WF command returns a fixed pattern of data. This command can be used to verify the
communications link. The command format is:

WF CR LF

The data fields are fixed at the following values:

Status F

Wind direction 678

Peak wind direction 567

Wind averaging time 21

Peak wind averaging time 09

Wind speed 876.5

Peak wind speed 432.1

Example of WF output:

WFF6785672109876.5432.1K99xx

5.21.2 WS425 F/G ASOS Data Message
WMT700 responds to the WA command with a data message.
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• The sensor status (byte 4) indicates the following:

• P (Pass) indicates that all diagnostic tests have passed and WMT700 is functioning
normally.

• F (Fail) indicates that one or more of the diagnostic tests have failed. You can then
request diagnostics and extended tests (WS) to further isolate the problem.

• H (Heater failure) indicates that the wind reading is valid but one or more built-in
heater diagnostic tests have failed.

• When the status byte is F, the wind direction fields are set to 999 and the wind speed
fields are set to 999.9 in the applicable sensor response messages.

• The signal quality (bytes 26-27) is a numeric value from 0 to 99 representing the data
quality of processed data samples during the averaging time.
For example, a value of 99 signifies that all data samples were determined to be valid
and processed during the averaging time. If some samples were determined to be
"missing", these samples were not processed and the reported signal quality is a
proportional value less than 99.

• Bytes 28-29 are the modulo 256 hexadecimal checksum of the ASCII values calculated
for bytes from 2 to 27.

Table 49 WS425 F/G ASOS Data Message

Byte Description

1 Start of text

2 Sensor ID

3 Command identifier

4 Sensor status:

• P = Pass
• F = Fail
• H = Heater failure
For further information, see notes 1 and 2.

5-7 Averaged wind direction (degrees)

8-10 Wind direction (degrees) @ peak wind speed

11-12 Averaging time for wind speed and direction

13-14 Averaging time for peak wind speed and direction (seconds)

15-19 Averaged wind speed

20-24 Peak wind speed since last WA command

25 Wind speed unit:

• M = Miles per hour
• K = Knots
• L = Kilometers per hour
• T = Meters per second

26-27 Signal quality. For further information, see note 3.

28-29 Hex checksum. For further information, see note 4.
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Byte Description

30 End of text

31 Carriage return

32 Line feed

Example

WAP2131870503012.6014.7K99xx
Interpretation of the example message:

• Sensor ID: W
• Command identifier: A
• Sensor status: P = pass
• Averaged wind direction (degrees): 213
• Wind direction (degrees) @ peak wind speed: 187
• Averaging time for wind speed and direction: 05
• Averaging time for peak wind speed and direction (seconds): 03
• Averaged wind speed: 012.6
• Peak wind speed since last WA command: 014.7
• Wind speed units: K = knots
• Signal quality: 99
• Hex checksum (refer to note 4): xx

5.22 WS425 A/B NMEA Standard Profile
When the WS425 A/B NMEA Standard profile is configured, WMT700 sends messages
based on the configured automatic message interval. There are no operating commands
available for the user.

The following table lists configurable parameters and their allowed and default values for
the WS425 A/B NMEA Standard profile

Table 50 Configurable Parameters for WS425 A/B NMEA Standard Profile

Parameter Default
Value

Profile-Specific Allowed Values Description

address 1 String with 1 character Address for WMT700

autoInt 1 0.25 ... 1000

Resolution: 0.25

Automatic message interval in
seconds. Do not select a message
interval that is shorter than the
time it takes to send a data
message
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Parameter Default
Value

Profile-Specific Allowed Values Description

autoPort 1 1 = COM1 port

2 = COM2 port

Serial port to which WMT700
sends automatic data messages

autoSend 0 0 = Automatic messages disabled

19 = NMEA automatic data message

Automatic data message number.
Selects the data message format
for automatic messages

com1_protocol 0 1) 4 = WS425 A/B NMEA Standard Profile for serial port COM1

com2_protocol 0 4 = WS425 A/B NMEA Standard Profile for serial port COM2

com2_interf N/A 2) 0 = RS-485

1 = RS-422

3 = RS-232

Interface for serial port COM2

wndAvg 1 0.25 … 3600

Resolution: 0.25

Averaging time for wind
measurement in seconds

wndOrientation 0 0 = Array facing up

1 = Array facing down

Orientation of the array of
WMT700

wndUnit 0 2) 0 = Meters per second

1 = Miles per hour

2 = Kilometers per hour

3 = Knots

Wind speed unit

wndVector 1 0 = Scalar averaging Wind averaging method

1) The parameter has no protocol-specific default value. It is determined separately in the configuration code.
2) Wind speed unit and COM2 digital communication interface are defined in the order form. Default setting may be any of the

allowed options, and it can be verified from the unit’s configuration code.

5.22.1 WS425 A/B NMEA Standard Data Message
The standard variable length, comma-separated, MWV wind message is defined by NMEA
0183 V2.20 as follows:

$WIMWV,<dir>,<ref>,<spd>,<uni>,<sta>*<chk><CR><LF>

$WIMWV Fixed text

<dir> Wind angle: 0 to 359 degrees

<ref> Reference: R = Relative

<spd> Wind speed

<uni> Wind speed unit:

• K = Kilometers per hour
• M = Meters per second
• N = Knots
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<sta> Status:

• A = Data valid
• V = Invalid data

* Fixed text

<chk> Checksum (8-bit XOR, excluding $ and *)

<CR> Carriage return code, ASCII 0DH

<LF> Line feed code, ASCII 0AH

When the NMEA Standard profile is selected, the autoInt parameter must have a non-
zero value since no polling command is defined for this profile.

Missing Readings

If data is missing due to a measurement problem, the NMEA messages show V in the status
field. Wind speed and wind direction fields are left empty.

5.23 WS425 NMEA Extended Profile
(v. 0183)

When the WS425 A/B NMEA Extended profile is selected, you can set WMT700 to send
messages based on the configured automatic message interval or poll data using the $WIP
command.

Table 51 WS425 NMEA Extended Profile Parameter Descriptions

Parameter Default Value Profile-Specific Allowed Values Description

address A String with 1 character Address for
WMT700

autoInt 1 0.25 ... 1000

Resolution: 0.25

Automatic message
interval in seconds.
Do not select a
message interval
that is shorter than
the time it takes to
send a data
message

autoPort 2 1 = COM1 port

2 = COM2 port

Serial port to which
WMT700 sends
automatic data
messages
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Parameter Default Value Profile-Specific Allowed Values Description

autoSend 15 0 = Automatic messages disabled

15 = NMEA automatic data message

Automatic data
message number.
Selects the data
message format for
automatic
messages.

com1_protocol 0 1) 5 = WS425 A/B NMEA Extended Profile for serial
port COM1

com2_protocol 5 5 = WS425 A/B NMEA Extended Profile for serial
port COM2

com2_interf N/A 2) 0 = RS-485

1 = RS-422

3 = RS-232

Interface for serial
port COM2

wndAvg 3 0.25 … 3600

Resolution: 0.25

Averaging time for
wind measurement
in seconds

wndOrientation 0 0 = Array facing up

1 = Array facing down

Orientation of the
array of WMT700

wndUnit 0 2) 0 = Meters per second

1 = Miles per hour

2 = Kilometers per hour

3 = Knots

Wind speed unit

wndVector 0 0 = Scalar averaging Wind averaging
method

1) COM1 service port is always by default 0 - WMT700 protocol. This can be changed using serial commands if COM1 is needed
for protocol-specific communication

2) Wind speed unit and COM2 digital communication interface are defined in the order form. Default setting may be any of the
allowed options, and it can be verified from the unit’s configuration code.

5.23.1 WS425 A/B NMEA Extended Commands
This command polls data from WMT700.

$WIP<id>Q,*<chk><CR><LF>

$WIP Fixed text

<id> Data ID; A … Z

Q Fixed text

* Fixed text

<chk> Checksum (8-bit XOR, excluding $ and *)
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<CR> Carriage return code, ASCII 0DH

<LF> Line feed code, ASCII 0AH

To use WMT700 with the NMEA Extended profile, either set the autoSend parameter to
0 to enable polling or define a fixed output interval with the autoInt parameter. If you
are using automatic messages, the value for the autoSend parameter must be set to 15.

Table 52 Checksum Table

ID Character
<id>

Checksum
<chk>

Polling String

A 72 $WIPAQ,*72<CR><LF>

B 71 $WIPBQ,*71<CR><LF>

C 70 $WIPCQ,*70<CR><LF>

D 77 $WIPDQ,*77<CR><LF>

E 76 $WIPEQ,*76<CR><LF>

F 75 $WIPFQ,*75<CR><LF>

G 74 $WIPGQ,*74<CR><LF>

H 7B $WIPHQ,*7B<CR><LF>

I 7A $WIPIQ,*7A<CR><LF>

J 79 $WIPJQ,*79<CR><LF>

K 78 $WIPKQ,*78<CR><LF>

L 7F $WIPLQ,*7F<CR><LF>

M 7E $WIPMQ,*7E<CR><LF>

N 7D $WIPNQ,*7D<CR><LF>

O 7C $WIPOQ,*7C<CR><LF>

5.23.2 WS425 A/B NMEA Extended Data Message
WS425 A/B NMEA Extended data message is as follows:

$P<id>MWV,<dir>,<ref>,<spd>,<uni>,<sta>*<chk><CR><LF>

$P Fixed text

<id> Data ID; A … Z
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MWV Fixed text

<dir> Wind angle: 0 to 359 degrees

<ref> Reference: R = relative

<spd> Wind speed

<uni> Wind speed unit:

K = Kilometers per hour

M = Meters per second

N = Knots

<sta> Status:

A = Valid data

V = Invalid data

* Fixed text

<chk> Checksum (8-bit XOR, excluding $ and *)

<CR> Carriage return code, ASCII 0DH

<LF> Line feed code, ASCII 0AH

Missing Readings

If data is missing due to a measurement problem, the NMEA messages show "V" in the
status field. Wind speed and wind direction fields are left empty.

5.24 WS425 A/B ASCII Profile

In Vaisala WINDCAP Ultrasonic Wind Sensor WS425 User's Guide, this profile was called
the Handar mode.

The following table lists the configurable parameters and their allowed and default values
for the WS425 A/B ASCII Profile.

Parameter Default
Value

Profile-Specific Allowed Values Description

autoInt 1 0.25 ... 1000

Resolution: 0.25

Automatic message interval in
seconds.

Do not select a message interval
that is shorter than the time it
takes to send a data message.

autoPort 1 • 1= COM1 port
• 2= COM2 port

Serial port to which WMT700
sends automatic data messages.
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Parameter Default
Value

Profile-Specific Allowed Values Description

autoSend 0 0 = Automatic messages disabled Automatic data message number.
Selects the data message format
for automatic messages.

com1_protocol 0 1) 3 = WS425 A/B ASCII Profile for serial port COM1

com2_protocol 3 3 = WS425 A/B ASCII Profile for serial port COM2

com2_interf N/A 2) • 0 = RS-485
• 1 = RS-422
• 3 = RS-232

Interface for serial port COM2

wndOrientation 0 • 0 = Array facing up
• 1 = Array facing down

Orientation of the array of
WMT700

wndUnit 0 2) • 0 = Meters per second
• 1 = Miles per hour
• 2 = Kilometers per hour
• 3 = Knots

Wind speed unit

wndVector 0 0 = Scalar averaging Wind averaging method

1) The parameter has no protocol-specific default value. It is determined separately in the configuration code.
2) Wind speed unit and COM2 digital communication interface are defined in the order form. Default setting may be any of the

allowed options, and it can be verified from the unit’s configuration code.

5.24.1 WS425 A/B ASCII Commands
The following commands are available for operating WMT700 with the WS425 A/B ASCII
profile.

Table 53 WS425 A/B ASCII Commands

Command Description

I Requests identification information for WMT700.

Wx Starts measurement based on averaging time and fetches the data.

You cannot use the WS425 A/B ASCII command Measurement Unit Change Ux with
WMT700. For a list of configuration commands for WMT700, see A. Command Set for
WMT700 (page 181).

5.24.1.1 I — Identify Sensor

This command shows the vendor, model number, and version information of WMT700.

I
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VAISALA WMT700 200

5.24.1.2 Wx — Start Measurement

This command starts wind measurement based on averaging time and fetches the data
automatically when the measurement has finished. You must specify the averaging time in
the command.

The averaging time supplied in the command (x) sets the averaging time for WMT700.
When you change the averaging time, it applies to the next new wind value.

Wx

x Time for averaging wind speed and wind direction. The range is from 1 to 9

WMT700 responds to the Wx command with a 19-character fixed-length data message.

Character Description

1 ┐02H (<STX>, start of transmission)

2 W

3 Averaging in seconds

4 Status: P = Pass F = Fail

5 Wind direction (most significant digit)

6 Wind direction (middle digit)

7 Wind direction (least significant digit)

8 Wind speed (most significant digit)

9 Wind speed (next digit)

10 Wind speed (next digit)

11 Wind speed (least significant digit)

12 . (dot character)

13 Wind speed (tenth digit)

14 Wind speed unit:

M = Miles per hour

K = Knots

L = Kilometers per hour

T = Meters per second
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Character Description

15 Checksum (most significant digit). For more information, see the note below.

16 Checksum (least significant digit)

17 └ 03H (<ETX>, end of transmission)

18 CR (carriage return)

19 LF (line feed)

The checksum is calculated from the characters from position 2 to 14. The accumulator
initializes at 0 with the addition of the byte value. The checksum has a range of 0H … FFH.

Example
W5 W5P1200013.2TDE

Interpretation of the example message:

• ┐ 02H (<STX>, start of transmission)
• Sensor ID: W
• Averaging in seconds: 5
• Sensor status: P = pass
• Wind direction: 120
• Wind speed: 0013
• . (dot character)
• Wind speed unit: T = meters per second
• Checksum (most significant digit): D
• Checksum (least significant digit): E
• └ 03H (<ETX>, end of transmission)

Missing Readings

If data is missing due to a measurement problem, the WS425 A/B ASCII message reports
999.9 for wind speed.

5.25 WS425 A/B WAT11 Profile
The following table lists the configurable parameters and their allowed and default values
for the WS425 A/B WAT11 profile.
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Table 54 Configurable Parameters for WS425 A/B WAT11 Profile

Parameter Default Value Profile-Specific Allowed Values Description

com1_protocol 0 1) 6 = WS425 A/B WAT11 Profile for serial port COM1

com2_protocol 0 6 = WS425 A/B WAT11 Profile for serial port COM2

1) The parameter has no protocol-specific default value. It is determined separately in the configuration code.

5.25.1 WS425 A/B WAT11 Commands
When the WS425 A/B WAT11 profile is selected, you can poll data using the following
command:

<esc><id>

<esc> Escape character ASCII 27H

<id> WMT700 ID, for example, A

Response:

<stx><id><spd><dir>

<stx> Start of text character (1 digit)

<id> WMT700 identification character, for example, A (1 digit)

<spd> Wind speed (in meters per second) multiplied by 10. For example, 045 is 4.5 meters per
second (3 digits).

<dir> Wind direction with two octal numbers for 6-bit binary data, for example, 73
corresponds to (7×8+3)/64×360 = 332 degrees

Missing Reading

The WS425 A/B WAT11 message reports missing data as slashes (/////).

5.26 SDI-12 Profile (v 1.3)
SDI-12 is a standard for interfacing data recorders with microprocessor-based sensors. The
name stands for serial/digital interface at 1200 baud.

The SDI-12 Support Group is an association of companies that produce and use SDI-12
products with the purpose of reviewing requests to enhance, clarify, or modify the SDI-12
architecture and that votes on proposed changes to SDI-12.
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For the complete SDI-12 standard text and information on the SDI-12 Support Group, see the
SDI-12 web-site: www.sdi-12.org.

SDI-12 sub-modes A and B are not supported by WMT700.

When establishing the terminal connection to WMT700, set the following communication
settings for the SDI-12 profile:

• Bits per second: 1200
• Data bits: 7
• Parity: 1
• Stop bits: 1
• Flow Control: None

The following table lists the configurable parameters and their allowed and default values
for the SDI-12 profile.

Table 55 Configurable Parameters

Parameter Default
Value

Profile-Specific Allowed
Values

Description

address 1 1, 2, 3, 4, 5, 6, 7, 8, 9 Address for WMT700

autoPort 1 1 = COM1 port

2 = COM2 port

Serial port to which WMT700 sends
automatic data messages

autoSend 0 0 = Automatic messages
disabled

Automatic data message number. Selects
the data message format for automatic
messages.

com1_protocol 0 1) 1 = SDI-12 Profile for serial port COM1

com2_baud 1 1 = 1200 Baud rate for serial port COM2.

Changes take effect only after reset or the
RESET command.

Note that low bit rate can affect
measurement timing, if WMT700 cannot
send the data message before new
measurement starts.

com2_data 7 7 = 7 data bits Data bits for serial port COM2.

Changes take effect only after reset or the
RESET command.

com2_interf 0 2) 2 = SDI-12 Interface for serial port COM2

WMT700 User Guide M211095EN-H

152



Parameter Default
Value

Profile-Specific Allowed
Values

Description

com2_parity 1 1 = Even Parity for serial port COM2.

Changes take effect only after reset or the
RESET command.

com2_protocol 1 1 = SDI-12 Profile for serial port COM2

com2_stop 1 1 = 1 bit Stop bits for serial port COM2.

Changes take effect only after reset or the
RESET command

wndAvg 1 0.25 … 3600

Resolution: 0.25

Averaging time for wind measurement in
seconds

wndOrientation 0 0 = Array facing up

1 = Array facing down

Orientation of the array of WMT700

wndUnit 0 2) 0 = Meters per second

1 = Miles per hour

2 = Kilometers per hour

3 = Knots

Wind speed unit

wndVector 0 0 = Scalar averaging Wind averaging method

1) The parameter has no protocol-specific default value. It is determined separately in the configuration code.
2) Wind speed unit and COM2 digital communication interface are defined in the order form. Default setting may be any of the

allowed options, and it can be verified from the unit’s configuration code.

To start continuous measurement, use the START command. To stop measurement, use the
STOP command.

5.26.1 SDI-12 Commands

You can only use COM2 serial port for sending commands and receiving data messages
with the SDI-12 profile.

The following table lists the available commands for operating WMT700 with SDI-12 profile.

Table 56 SDI-12 Commands

Command Description

?! Queries WMT700 for its address.

a! Ensures that WMT700 is responding.

aI! Queries WMT700 for its SDI-12 compatibility level, model number, and firmware version
number.

aAb! Changes WMT700 address.
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Command Description

aC! Starts concurrent measurement.

aCC! Starts concurrent measurement with CRC calculation.

aD0! Fetches instant data from WMT700.

aM! Starts measurement.

aMC! Starts measurement with CRC calculation.

aV! Starts verification.

The following SDI-12 commands cannot be used with WMT700:

• Measurement Unit Change Command aXUx!
• Heater Control Command aXHx!
• Check Current Sub mode aX?!
• Place Sensor in Sub mode B Command aXQx;c.c;n;yyyy!
• Reset the Sensor to Sub mode A Command aXS!
• Check Current Measurement Unit Command aX*!
• Continuous Measurement aR0!

More Information

‣ Command Set for WMT700 (page 181)

5.26.1.1 ?! — Address Query

This command queries for the WMT700 address.

When you use a question mark (?) as the address character with the a! command, WMT700
responds as if it was being addressed on the SDI-12 bus. Regardless of its address, WMT700
responds to the command, which allows you to determine the address for the wind sensor.

If more than one WMT700 is connected to the bus, they all respond, causing a bus
contention.

?!

? Wildcard

! Terminates the command

The response:
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a<CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value

<CR><LF> Terminates the response

5.26.1.2 a! — Acknowledge Active

This command ensures that WMT700 is responding to a data recorder or another SDI-12
device. It asks WMT700 to acknowledge its presence on the SDI-12 bus.

a!

a Single-digit WMT700 address that corresponds to the first character of the address
value

! Terminates the command

The response:

a<CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value

<CR><LF> Terminates the response

1!1<CR><LF>

5.26.1.3 aAb! — Change Address

This command changes the WMT700 address. After WMT700 has received this command
and sent a response, the sensor does not respond to any other command for one second.
This gives WMT700 time to write the new address to the non-volatile memory.

You can also change the WMT700 address by entering configuration mode and changing
the address parameter.
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aAb!

a Current single-digit WMT700 address that corresponds to the first character of the
address value

A Change address command

b New address

! Terminates the command

The response:

b<CR><LF>

b New single-digit WMT700 address (or the original address if WMT700 is unable to
change the address)

<CR><LF> Terminates the response

5.26.1.4 aC! — Start Concurrent Measurement

This command starts concurrent measurement. WMT700 does not return measurement data
after this command. It sends a response that indicates when the measurement result can be
retrieved using the aD0! command and the number of parameters.

aC!

a Single-digit WMT700 address that corresponds to the first character of the address
value

C Start concurrent measurement command

! Terminates the command.

The response:

atttnn<CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value
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ttt Period of time, in seconds, after which WMT700 has the measurement ready

nn Number of measurement values WMT700 calculates and returns as a response to one or
more subsequent aD0! commands

<CR><LF> Terminates the response.

1C! 100205<CR><LF>

Interpretation of the example message:

• Time after which the measurement is ready: 2 seconds
• Number of returned measurement values: 5

To fetch the measurement results, use the aD0! command.

5.26.1.5 aD0! — Send Data

This command fetches instant data from WMT700. aD0! must be preceded by a C!, M!, or
V! command. WMT700 responds by sending measurement data (after C! or M!) or
verification data (after V!).

In a SDI-12 system compliant with the standard, if the expected number of measurements is
not returned in response to an aD0! command, a data recorder issues D1!, D2!, and so on,
until all measurement values are received. The expected number of measurements is
included in the message that WMT700 sends in response to an aC!, aM! or aV! command.
Multiple data requests are not needed with WMT700, since all return values fit in one
response string.

aD0!

a Single-digit WMT700 address that corresponds to the first character of the address
value

D0 Send data command

! Terminates the command

More Information

‣ SDI-12 Data Messages (page 160)

5.26.1.6 aI! — Send Identification

This command queries WMT700 for its SDI-12 compatibility level, model number, and
firmware version number.
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aI!

a Single-digit WMT700 address that corresponds to the first character of the address
value

I Send identification command

! Terminates the command

The response:

allccccccccmmmmmmvvvxxx . . . xxx<CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value

11 SDI-12 version number, indicating SDI-12 version compatibility; for example, version 1.1 is
encoded as 11

cccccccc 8-character vendor identification Vaisala

mmmmmm 6 characters specifying the model number of WMT700

vvv 3 characters specifying the firmware version 604

xxx ... xxx Optional field, up to 13 characters, used for a serial number or other specific WMT700
information that is not relevant for operation of the data recorder (not used)

<CR><LF> Terminates the response

5.26.1.7 aM! — Start Measurement

This command starts measurement. WMT700 does not return measurement data after this
command. It sends a response that indicates when the measurement result can be retrieved
using the aD0! command and the number of parameters.

aM!

a Single-digit WMT700 address that corresponds to the first character of the address
value

M Start measurement command

! Terminates the command.

The response:
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atttn<CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value

ttt Period of time, in seconds, after which WMT700 has the measurement ready

n Number of measurement values WMT700 calculates and returns as a response to one or
more subsequent aD0! commands

<CR><LF> Terminates the response.

Example
1M! 10025<CR><LF>

Interpretation of the example message:

• Time after which the measurement is ready: 2 seconds
• Number of returned measurement values: 5

To fetch the measurement results, use the aD0! command.

5.26.1.8 aV! — Start Verification

This command starts verification. However, WMT700 does not return verification data
directly after this command. It sends a response that specifies when the verification results
can be retrieved using the aD0! command and the number of parameters. The WMT700
verification data includes a watchdog count, sensor measurement unit settings, and the
current SDI mode setting.

The command:

aV!

a Single-digit WMT700 address that corresponds to the first character of the address
value

V Starts verification command

! Terminates the command

The response:

atttn<CR><LF>
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a Single-digit WMT700 address that corresponds to the first character of the address
value

ttt Period of time, in seconds, after which WMT700 has the verification data ready

n Number of returned verification data fields

<CR><LF> Terminates the response

Example
1V! 10014<CR><LF>

Interpretation of the example message:

• Time when the measurement is ready: 1 second
• Number of returned measurement values: 4

To fetch the measurement results, use the aD0! command.

5.27 SDI-12 Data Messages
When the SDI-12 profile is selected, the data message sent by WMT700 depends on the
command that you use before fetching the data with the aD0! command.

5.27.1 WS425 A/B SDI-12 Message for C and M Command
When you give the commands aC! or aM! followed by aD0!, the response is:

 a<WS><WD><x><y><s><CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value

<WS> Polar wind speed in selected units

Format: +(ss)s.s

<WD> Polar wind direction in degrees

Format: +(dd)d.d

<x> x component of wind speed in selected units

Format: ±(ss)s.s

<y> y component of wind speed in selected units

Format: ±(ss)s.s

<s> Static speed of sound in miles per hour

Format: ±(ss)s.s
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<CR><LF> Terminates the response.

The above are measurement data fields.

Missing Readings

If data is missing due to a measurement problem (for example, blocked paths between
transducers), the measurement data is replaced with 999.9.

Example
Example of the command and response when data is missing:

7D0! 7+999.9+999.9+999.9+999.9+999.9 <CR><LF>

5.27.2 WS425 A/B SDI-12 Message for V Command
When you have given the commands aV! and aD0!, the response is the following:

a<watchdog><WS_unit><SDI-mode><spare><CR><LF>

a Single-digit WMT700 address that corresponds to the first character of the address
value

<watchdog> Number of times the watchdog has triggered. Ideally should be zero. Format: +(c)c

<WS_unit> Wind speed unit. The options are:

• +0 = mph
• +1 = kt
• +2 = km/h
• +3 = m/s

<SDI-mode> Current sub mode setting. The options are:

• +0 = SDI-12 sub mode A
• +1 = SDI-12 sub mode B

<spare> 1 digit for factory use, format: +c

<CR><LF> Terminates the response

The above are verification data fields.

5.27.3 Requesting Cyclic Redundancy Check
Error detection capability can be enhanced by using the aCC! or aMC! command to start
the measurement. These commands have the same function and send the same response as
commands aC! and aM! respectively. The difference is that Cyclic Redundancy Check is
appended to the data returned by the aD0! command.
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The 16-bit Cyclic Redundancy Check value is appended to the response of the aD0!
command before <CR><LF>. It is encoded as three ASCII characters using the following
algorithm:

1st character=0x40 OR (CRC shifted right 12 bits)
2nd character=0x40 OR ((CRC shifted right 6 bits) AND 0x3F)
3rd character=0x40 OR (CRC AND 0x3F)

Example
1MC! 10025<CR><LF> 1D0! 1+2.7+85.2-0.2-2.7+770.5CAH<CR><LF>
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6. Maintenance

6.1 WMT700 Maintenance
WMT700 is a very reliable and rugged sensor. Since no moving or consumable parts are
used, only minimal periodic maintenance is required.

Periodic maintenance for WMT700 includes:

• Checking that the transducers are not bent, twisted, or rotated. All transducers must be
parallel to each other. Damaged array may cause inaccurate readings.

• Checking that the transducers have not been scraped or touched with sharp objects.
The silicon rubber coating must be undamaged. If the transducers or the coating is
damaged, send the sensor to Vaisala for repair.

• Verifying functionality by using the optional verifier to check the distance between
transducers.

WMT700 has been calibrated at the factory, and recalibration is not required. Periodic
calibration of WMT700 is not required for technical reasons. However, some quality
management systems may require regular calibration of the measuring instruments. To fulfill
these requirements, it is recommended that you recalibrate the sensor every 24 months. For
more information, contact Vaisala Service Center.

If the sensor becomes contaminated, cleaning the sensor carefully using a soft, lint-free
cloth moistened with mild detergent. Do not use solvents or a pressure washer to clean the
sensor, since they may damage the silicon rubber transducer sleeve.

Do not clean the instrument or sensor unless it is clearly contaminated.CAUTION!

Some instruments and sensors or versions are heated. To avoid injury, do
not touch heated parts when heating is on.
WARNING!

Handle with care. Any impact on the instrument or sensor array may cause
damage and lead to incorrect measurements.
CAUTION!
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Any temporary object (such as snow, ice, or a bird) that blocks the
observation path between the ultrasonic transducer heads may lead to inaccurate or
incorrect measurements.

CAUTION!

Do not open the instrument or sensor. There are no user-serviceable parts
inside.
CAUTION!

In maritime environments, it is not possible to perform WMT700 software updates.

6.2 Testing Operation

Optional verifier (WMT70VERIFIER)

WMT700 measures the time it takes for an ultrasonic signal to travel from one transducer to
another. Therefore, the accuracy of the sensor depends on the distance between the
transducers and the time-of-flight measurement circuit, which uses a crystal oscillator for its
time reference.
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If necessary, you can verify the distance between the transducer arms with an optional
verifier. You can order the verifier from Vaisala as an accessory.

Vaisala recommends that you test the proper operation once a year or if you suspect that
the transducers may have been damaged. You can perform the test either in the field or in a
laboratory.

Do not perform the test when the wind speed is more than 10 m/s (22 mph) or when there
is a risk of thunderstorm in the area.

Some random data samples may be lost during the verifier test. This does not indicate
that sensor or instrument is faulty.

Disable heating before performing the verifier test.

To disable heating, disconnect the heater supply voltage or set the heaterOn parameter to
0.

1. Slip the verifier over the 3 transducers. 

2. Start wind measurement. The command depends on the selected communication
profile.

3. Make sure that WMT700 reads less than 0.22 m/s (0.5 mph) with the verifier in place.
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4. Remove the verifier.
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7. Troubleshooting

7.1 Problem Situations

Problem Probable Cause Remedy

Connection to WMT700 is
lost.

Power supply is not sufficient. Check that the power supply
matches the requirements listed in
4.10 Powering (page 76).

Wind measurement failure.
WMT700 is sending irregular
data values.

The installation site is causing
measurement problems.

Check that the installation site
matches the requirements listed in
4.2 Placing WMT700 (page 51).

Snow, ice, a bird, or some other object is
blocking the measurement path
between the ultrasonic transducers.

Remove the blockage and check
that the wind transducers are not
damaged. If the blockage is ice or
snow, it melts after some time if
you are using a heated version of
WMT700. Duration of the blockage
depends on the severity of the
weather event. If birds are causing
the blockage, consider installing a
bird cage.

Reported wind direction is not
correct.

WMT700 is misaligned, which causes an
offset error.

Realign WMT700 according to 4.7
Aligning WMT700 (page 63).

Wind direction indication acts
erratically.

Orientation of the sensor does not
match the wndOrientation
parameter value.

Set the wndOrientation parameter
value according to the actual
orientation of the sensor. See D.
Configuration Parameter
Descriptions (page 187).

There is no response when
you try to switch to
configuration mode with the
OPEN command.

The WMT700 settings are unknown or
they have been accidentally changed.

Reset the serial communication
settings to default values. See 7.3
Restoring Serial Port Settings
(page 170).

WMT700 does not respond to
any commands.

The communication profile is not
correct.

Configure the communication
profile to match the host
communication profile.

The wiring might be incorrect. Check the wiring, see 4.9 Wiring
(page 72).

Connection works but data
messages are not available.

The command has been mistyped. Use the ERRORS command to fetch
the error messages from
WMT700.See 5.6.1 ERRORS — Get
Error Codes and Counts
(page 106).
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Problem Probable Cause Remedy

Data messages are not in the
expected format.

The selected data message is not
correct.

If you are using automatic
messages: check the selected data
message with the G command. If
necessary, set a new value for the
autoSend parameter. If you are
using polling: Check that you are
using the correct data message
number in the polling command,
see Table 44 (page 119).

Some items are missing from
the data messages.

The configured data message does not
contain all the required items.

Define the data message again
with the required items. See 5.4
Parameter Handling Commands
(page 102).

Configuration commands do
not work.

WMT700 is in measurement mode. Switch from measurement mode to
configuration mode. See 5.1
Communicating with Terminal
Software (page 99).

WMT700 sends an error
message as a response to a
command.

For probable causes, see 7.2 Error and
Event Messages (page 169).

For remedies, see 7.2 Error and
Event Messages (page 169).

No signal is present on analog
outputs.

Analog output has been disabled. Enable analog output with the
aout1_mode and aout2_mode
parameters. See D. Configuration
Parameter Descriptions
(page 187).

Automatic data messages are
not received although
parameters have been set
correctly.

WMT700 is not in continuous
measurement mode.

Initiate continuous measurement
with START command. See 5.5.2
START — Start Continuous
Measurement (page 106).

Data from WMT700 is
temporarily lost.

The data logger and wind sensor are not
in the same operating mode (polling or
automatic transmission mode).

Make sure that the data logger and
wind sensor are both in either
polling or automatic transmission
mode.

Data messages are not
received.

Baud rates of the data logger and wind
sensor do not match.

Change the baud rate so that it is
the same in the data logger and
wind sensor.

Parameter does not change
after S command has been
given.

The parameter requires reset before it
becomes valid.

Check D. Configuration Parameter
Descriptions (page 187) if reset is
required before the parameter is
changed.

Inconsistent serial
communication or missing
data.

Pin contacts of the connector have
become oxidized or the connector is not
firmly attached.

Change the WMT700 cable.

Retrofit installation of
WMT700 is not possible.

You do not have the correct mounting
kit for the retrofit installation.

Check that you are using the
correct mounting adapter with
your mounting kit. See F. WMT700
Accessories (page 197).
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Problem Probable Cause Remedy

WMT700 does not work
properly after retrofit
installation.

Incorrect cables were used in the retrofit
installation.

Check that you have used cables
listed in 4.11.5 Connection Cable
Prerequisites (page 92). If you do
not have the correct cables,
contact Vaisala technical support.

Connection to WMT700 is
lost.

The power supply is not sufficient,
especially if you are using a heated
version of WMT700.

Check that the power supply
matches the requirements in 4.10
Powering (page 76).

7.2 Error and Event Messages
If the messages parameter is set to 1, WMT700 sends error and event messages. The
following table lists the available messages.

Table 57 Error and Event Messages

Error/Event
Code

Probable Cause Remedy

2 Event. Parameters have
been set to factory
defaults.

You can change the default settings in configuration mode; see
5.1 Communicating with Terminal Software (page 99).

3 Event. Wind calibration
data has been lost.
WMT700 needs to be
calibrated.

Contact Vaisala technical support.

10 Error. You have given an
invalid value when using
the S command.

Check the allowed parameter values; see E.1 Configurable
Parameters (page 193).

11 Error. Parameter used with
the S command is
unknown.

Check that you are using the correct parameter names, see E.1
Configurable Parameters (page 193).

12 Error. Unknown command. Check the allowed commands in A. Command Set for WMT700
(page 181).

13 Error. String before the end
of command character is
too long.

Check the command and parameter names that you are using.

You can also troubleshoot WMT700 as follows:

• Fetch the error and event messages with the ERRORS command.
• Include diagnostics-related items in the data message.

More Information

‣ Parameter Handling Commands (page 102)
‣ ERRORS — Get Error Codes and Counts (page 106)
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7.3 Restoring Serial Port Settings
If you are not familiar with the configured settings of WMT700, or if the settings have been
accidentally changed, you may not get any response when you send the OPEN command to
WMT700. In that case, restore the serial port settings to known values.

1. Connect a cable between your terminal computer, power supply, and WMT700.

2. Open the Windows HyperTerminal program. 

You can also use other terminal programs, such as Tera Term.

3. Cancel the new connection.

4. Select File > Properties.

5. Select the correct COM port and then Configure.

6. Regardless of the configured port settings of WMT700, select the following
communication settings: 

• Bits per second: 19200
• Data bits: 8
• Parity: None
• Stop bits: 1
• Flow Control: None

7. Close the New Connection Properties window.

8. Connect to WMT700 using the RS-485 interface.

9. Switch the sensor power supply off and back on.

10. Press # on your keyboard and hold down the key for at least five seconds. WMT700
responds by sending the string: 

Ok
Restoring COM1 and COM2 settings…

Updating the settings is completed in a few seconds. When the operation is done,
WMT700 sends the following response: 

Done. Rebooting…

WMT700 has now applied the settings and reboots using the new settings. For the
restored settings, see the table below.

11. Before you start configuring new values to WMT700, apply the new settings to
HyperTerminal. To close the connection, select Call > Disconnect.
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12. Select File > Properties.

13. Select Properties > Configure.

14. In Bits per second, select 9600.

15. Close the Properties window.

16. Select Call > Call. 

Table 58 Restored Serial Port Settings

Parameter Name Default Value Description

com1_baudcom2_baud 4 4 = 9600 bauds per second

com1_data
com2_data

8 Number of data bits

com1_delay
com2_delay

20 Response delay in milliseconds

com2_interf 0 0 = RS-485

com1_parity
com2_parity

0 0 = None

com1_protocol
com2_protocol

0 WMT700 protocol

com1_stop
com2_stop

1 Number of stop bits

The serial port settings have now been restored to known values. You can write the
OPEN command and start configuring WMT700.

More Information

‣ Configuration (page 101)
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8. Technical Data

8.1 Measuring Specifications

Table 59 WMT700 Wind Speed Measuring Specifications

Property Description/Value

Observation range WMT701: 0 ... 40 m/s (89 mph)

WMT702: 0 ... 65 m/s (145 mph)

WMT703: 0 ... 75 m/s (168 mph)

WMT704: 0 ... 90 m/s (201 mph)

Starting threshold 0.01 m/s (0.0223 mph)

Resolution 0.01 m/s (0.0223 mph)

Response time 250 ms

Accuracy 0 ... 75 m/s: (168 mph) ±0.1 m/s or 2% of reading,
whichever is greater

75 ... 90 m/s (201 mph): ±5% of reading

Available variables Instant, peak, average, maximum, minimum, gust, lull

Table 60 WMT700 Wind Direction Measuring Specifications

Property Description/Value

Observation range 0 … 360°

Starting threshold 0.1 m/s

Resolution 0.01°

Response time 250 ms

Accuracy ±2°

Available variables Instant, average, maximum, minimum

Any temporary object (such as snow, ice, or a bird) that blocks the
observation path between the ultrasonic transducer heads may lead to inaccurate or
incorrect measurements.

CAUTION!
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In extreme weather conditions, ice or snow accumulation may cause a temporary wind
observation blackout even when heating is enabled.

8.2 Electrical Specifications

Table 61 WMT700 Electrical Specifications

Property Description/Value

Operating voltage 9 ... 36 VDC (absolute maximum 40 VDC) 1)

Heating voltage 24 ... 36 VDC (absolute maximum 40 VDC) 1)

Heating power supply requirement

No heating 1.50 W at 24 V

Heated transducers 31.50 W at 24 V (peak 40 W) 2)

Heated transducers and arms 151.50 W at 24 V (peak 200 W) 2)

Heated transducers, arms, and body 251.50 W at 24 V (peak 350 W) 2)

1) In maritime environments, the normal input voltage ranges are: operating voltage 10 … 30 VDC (-10% … +30%) and
heating voltage 24 … 30 VDC (-10% … +30%), as defined in the maritime standard IEC  60945.

2) The actual power consumption depends on the temperature.

Table 62 WMT700 Output Specifications

Property Description/Value

Readout update interval Maximum 4 Hz

Units available m/s, knots, mph, km/h, V, mA, Hz

Operating mode Automatic message or poll mode

Virtual temperature Celsius degrees

Digital outputs

Communication interfaces COM1: RS‑485

COM2: RS‑485, RS‑422, RS‑232, SDI‑12

Communication profiles WMT700, WS425 ASCII, NMEA Standard and
Extended (version 0183), SDI-12 (version 1.3), WS425
ASOS, ROSA - MES12, Customized

Bit rate 300, 1200, 2400, 4800, 9600, 19200, 38400, 57600,
or 115200

Available averages Maximum 3600 s
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Property Description/Value

Analog outputs for wind speed

Frequency push-pull Pulse 0 V/10 V: 0 ... 2 kHz (f = 10 Hz/m/s) (load > 10
kohm)

Frequency pull-down Pulse 0.5 V/Vin-2 V (11 V minimum):

0 ... 750 Hz (load 50 kohm ±20 %)

Frequency pull-up Pulse 1.5 V/Vin-4 V (8 V minimum):

Voltage 0 ... 10 V (U = 100 mV /m/s)

Current 0 ... 20 mA (I = 0.2 mA/m/s)

Analog outputs for wind direction

Voltage 0 ... 10 V (U = 20 mV/°)

Current 0 ... 20 mA (I = 50 uA/°)

Potentiometer Reference voltage 1 ... 10 VDC, 0 ... Vref represents 0 ...
359°

8.3 Environmental Specifications

Table 63 WMT700 Environmental Specifications

Property Description/Value

Operating temperature ‑10 ... +60 °C (+14 ... +140 °F)

-40 °C ... +60 °C (-40 ... +140 °C), or

-55 ... +70 °C (-67 ... +158 °F)

Storage temperature ‑60 ... +80 °C (‑76 ... +176 °F)

Operating humidity 0 ... 100 %RH

IP rating IP66 and IP67

EMC IEC 61000-4-2 ... 6

Emissions CISPR22

Environmental IEC 60068-2-1,2,6/34, 30, 31, 67, 78, IEC 60529; VDA
621-415

Maritime DNVGL-CG-0339; Lloyd's Register requirements; IEC
60945

Chapter 8 – Technical Data

175



8.4 Mechanical Specifications

Table 64 WMT700 Mechanical Specifications

Property Description/Value

Dimensions (H × W × D) 350 × 250 × 285 mm (13.78 × 9.84 × 11.22 in)

Weight

WMT700 wind sensor 1.8 kg (4.0 lb)

Mounting adapter 0.3 kg (0.7 lb)

WMT70FIX mounting kit 1.4 kg (2.2 lb)

Materials

Body and arms, mounting kit Stainless steel AISI 316

Transducers Silicone

Figure 46 WMT700 Dimensions
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Figure 47 WMT70FIX Mounting Kit Dimensions

Figure 48 ASOS Mounting Adapter Dimensions

8.5 Accessory List

Table 65 Tools

Item Order Code

Zero Wind Verifier WMT70Verifier

Chapter 8 – Technical Data

177



Item Order Code

Cable Tightening Tool 237888SP

Table 66 Bird Obstructions

Item Order Code

Bird cage WMT70BirdKit

Bird perch WS425BirdPerch

Table 67 Cables

Item Order Code

Cable connector WMT70Conn

Cable 2 m, cable connector, open leads on one end 227567SP

Cable 10 m, cable connector, open leads on one end 227568SP

Cable 15 m, cable connector, open leads on one end 237890SP

Cable 26 m, cable connector, open leads on one end 237889SP

RS-485 Cable 2 m, cable connector, open leads on one end 228259SP

RS-485 Cable 10 m, cable connector, open leads on one end 228260SP

MAWS cable 10 m 227565SP

AWS520 cable 10 m, shield connected to PE pin 229807SP

AWS520 cable 10 m, shield not connected to PE pin 227566SP

ROSA analog cable 10 m, cable connector, open leads on one end 231425SP

Adapter cable for WS425 serial 227569SP

Adapter cable for WS425 analog frequency output 227570SP

Adapter cable for WS425 analog voltage output 227571SP

Junction Box with Cable 2 meters ASM210719SP

Table 68 WMT700 Mounting Accessories

Item Order Code

Adapter for FIX70 228869

General purpose mounting adapter (suitable also for inverted mounting) WMT70FIXSP

Plastic mounting adapter for 60 mm tube WMT700FIX60-POM

Stainless steel mounting adapter for 60 mm tube WMT700FIX60-RST
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Item Order Code

Cross-arm (requires WMT70FIX mounting adapter) WMT70CROSSARM

ASOS mounting adapter ASM212140

Table 69 WS425 Mounting Accessories

Item Order Code

Adapter for WS425FIX30, WS425FIX60-POM, and WS425FIX60-RST 228777

Mounting adapter for 30 mm tube WS425FIX30

Aluminum mounting adapter for 60 mm tube WS425FIX60

Sensor support arm for 60 mm pole (655 mm with integrated fix for item
228777)

WAC425
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Appendix A. Command Set for
WMT700
The following table lists all the commands available for WMT700.

Table 70 Command Set for WMT700

Configuration Mode / Measurement
Mode and Profile

Command Description

Configuration mode ? Displays a list of configuration commands.

Configuration mode BAUD Changes or displays serial port settings.

Configuration mode CLEARERR Resets error counters.

Configuration mode CLOSE Switches the serial port to measurement mode.

Configuration mode ERRORS Displays error codes and counts.

Configuration mode G Displays either all or specified parameters.

Configuration mode H Displays list of data messages and available values
for measurement unit, profile, baud rate, interface,
and analog output mode.

Configuration mode MEAS Starts wind measurement based on the user-
configurable averaging time. WMT700 does not
send data messages automatically.

Configuration mode POLL Tests data polling.

Configuration mode RESET Resets WMT700.

Configuration mode S Changes selected parameters or defines new data
messages.

Configuration mode START Starts continuous measurement.

Configuration mode STOP Stops continuous measurement.

Configuration mode VERSION Displays the software version.

Configuration mode WIND_GET Fetches wind calibration information.

Measurement Mode WMT700 profile MEAS Starts wind measurement. The duration of the
measurement is based on the user-configurable
averaging time.

Measurement mode WMT700 profile OPEN Switches the serial port to configuration mode.

Measurement mode WMT700 profile POLL Fetches data from WMT700.

Measurement mode WMT700 profile SLEEP Switches WMT700 from normal operating mode to
low-power mode.

Measurement Mode MES12 profile @a M 12 Polls data from WMT700 in the MES12 data message
format.
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Configuration Mode / Measurement
Mode and Profile

Command Description

Measurement mode WS425 ASOS F/G
profile

WA Requests average wind speed and direction
message.

Measurement mode WS425 ASOS F/G
profile

WS Requests the verbose Built-In Test (BIT) results.

Measurement mode WS425 ASOS F/G
profile

WT Requests the short response BIT results and status.

Measurement mode WS425 ASOS F/G
profile

WD Reports the BIT status.

Measurement mode WS425 ASOS F/G
profile

WF Returns a fixed pattern of data.

Measurement mode WS425 A/B NMEA
Extended profile

$WIP Polls data from WMT700.

Measurement mode WMT700 NMEA
MWV profile

$aabbQ,MWV Polls NMEA MWV message from WMT700.

Measurement mode WS425 A/B ASCII
profile

I Requests identification information from WMT700.

Measurement mode WS425 A/B ASCII
profile

Wx Starts measurement based on averaging time and
fetches the data.

Measurement mode WS425 A/B ASCII
profile

<esc><id> Polls data from WMT700.

Measurement mode SDI-12 profile ?! Queries WMT700 for its address.

Measurement mode SDI-12 profile a! Ensures that WMT700 is responding.

Measurement mode SDI-12 profile aI! Queries WMT700 for its SDI-12 compatibility level,
model number, and firmware version number.

Measurement mode SDI-12 profile aAb! Changes WMT700 address.

Measurement mode SDI-12 profile aC! Starts concurrent measurement.

Measurement mode SDI-12 profile aCC! Starts concurrent measurement.

CRC is included in the response.

Measurement mode SDI-12 profile aD0! Fetches instant data from WMT700.

Measurement mode SDI-12 profile aM! Starts measurement.

Measurement mode SDI-12 profile aMC! Starts measurement.

CRC is included in the response.

Measurement mode SDI-12 profile aV! Starts verification.
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Appendix B. Typical System
Environments
The following figure shows a system in which the weather station is connected to COM2,
while COM1 is left for service and maintenance purposes only. This is the recommended
setup for WMT700 serial communications.

Figure 49 System Environment with Serial Port COM1 Only

The following figure shows a system in which the weather station is only connected to the
analog output channel. Serial port COM1 is used for maintenance purposes.

Figure 50 System Environment with Analog Output Only
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The following figure shows a system in which serial ports COM1 and COM2 operate
independently. Serial port COM1 is used for maintaining WMT700 and monitoring the wind
sensor in mission-critical applications while COM2 provides continuous measurement data.

Figure 51 System Environment with Serial Ports COM1 and COM2

The following figure shows a system with a separate back-up battery for operating power.
The heating power is supplied with a direct power supply unit that prevents the heating
function from consuming the power supply for the operations. This setup is suitable for
WMT700 product types that provide heating for the wind sensor.

Figure 52 System Environment with Backup Battery
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Appendix C.  Default Settings
for Different Communication
Profiles

C.1 Default Settings for Different
Communication Profiles

Table 71 Default Settings for Different Digital Communication Profiles

Setting Parameter WMT700 WS425
ASCII

WS425
NMEA
Ext

WS425
SDI-12

WS425
F/G
ASOS

ROSA
MES12

Service port

Protocol com1_protocol WMT700 WMT700 WMT700 WMT700 WMT700 WMT700

Baud rate com1_baud 9600 9600 9600 9600 9600 9600

Data bits com1_data 8 8 8 8 8 8

Parity com1_parity 0 (None) 0 (None) 0 (None) 0 (None) 0 (None) 0 (None)

Stop bits com1_stop 1 1 1 1 1 1

Response
Delay

com1_delay 20 ms 20 ms 20 ms 20 ms 20 ms 20 ms

Data Port

Protocol com2_protocol WMT700 WS425
ASCII

WS452
NMEA Ext

SDI-12 WS425
F/G ASOS

ROSA
MES12

Baud rate com2_baud 9600 2400 9600 1200 2400 9600

Data bits com2_data 8 8 8 7 8 8

Parity com2_parity 0 (None) 0 (None) 0 (None) 1 (Even) 0 (None) 0 (None)

Stop bits com2_stop 1 1 1 1 1 1

Response
Delay

com2_delay 20 ms 20 ms 20 ms N/A 20 ms 20 ms

Other Parameters

Address address A A A 0 1 12

Automatic
message
number

autoSend Disabled
(0)

Disabled 15 Disabled Disabled Disabled
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Setting Parameter WMT700 WS425
ASCII

WS425
NMEA
Ext

WS425
SDI-12

WS425
F/G
ASOS

ROSA
MES12

Automatic
message
port

autoPort COM1 COM1 COM2 COM1 COM1 COM1

Automatic
data
message
interval

autoInt 1 s 1 s 1 s 1 s 1 s 1 s

Wind
averaging
time

wndAvg 1 s 1 s 3 s 1 s 5 s 600 s

Gust
averaging
time

wndGustTime 3 s 3 s 3 s 3 s 3 s 3 s

Installa-
tion
orienta-
tion of
WMT700

wndOrientation Array
facing up

Array
facing up

Array
facing up

Array
facing up

Array
facing up

Array
facing up

Wind
measure-
ment
averaging
method

wndVector Scalar
averaging

Scalar
averaging

Scalar
averaging

Scalar
averaging

Scalar
averaging

Scalar
averaging

The parameters in the following table do not have a protocol-specific default value. They are
defined in the configuration code.

Table 72 Parameters with No Protocol-specific Default Value

Setting Parameter WMT700 WS425
ASCII

WS425
NMEA
Ext

WS425
SDI-12

WS425
F/G
ASOS

ROSA
MES12

Interface
type

com2Interf N/A N/A N/A N/A N/A N/A

Wind speed
unit

wndUnit N/A N/A N/A N/A N/A N/A
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Appendix D. Configuration
Parameter Descriptions
Table 73 Configuration Parameter Descriptions

Parameter Name Default
Value

Allowed Values Units Description

address A String with a
maximum of 40
characters.

 Address for WMT700. Note
that the SDI12, ASCII, NMEA
Extended, ASOS, and MES12
profiles use the first character
only. SDI-12 only uses digits 1 …
9.

aout1erraout2err 1000 0 … 32000 V, A, Hz, % Value for AOUT1 and AOUT2
analog output if wind
measurement fails.

aout1_gaout2_g 1 0 ... 100  Gain for AOUT1 (wind speed)
and AOUT2 (wind direction)

aout1_oaout2_o 0 -10000 … 10000  Offset for AOUT1 and AOUT2

aout1maxvaout2maxv 32000 0 … 32000 V, A, Hz, % Analog output maximum value
for AOUT1 and AOUT2. The
output is fixed to this value.
The unit depends on analog
output mode.

aout1minvaout2minv 0 0 … 32000 V, A, Hz, % Analog output minimum value
for AOUT1 and AOUT2. The
output is fixed to this value.
The unit depends on the
analog output mode.

aout1mode 3 0 = Current

1 = Voltage

2 = Frequency

3 = Disabled

 Analog output mode for
AOUT1.

aout2mode 7 4 = Current

5 = Voltage

6 =
Potentiometer

7 = Disabled

 Analog output mode for
AOUT2.

autoInt 1 0.25 ... 1000
Resolution: 0.25

s Automatic message interval in
seconds. This parameter
affects both serial
communication and analog
output. Do not select a
message interval that is
shorter than the time it takes
to send a data message.
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Parameter Name Default
Value

Allowed Values Units Description

aout_map 0 0 =

aout1, wind
speed

aout 2, wind
direction

1 =

aout1, North-
South, x
component

aout 2, west-
east, y
component

2 =

aout1, wind
speed

aout2, wind
speed alarm

A digital output:
hi when wind
speed > aout2_o

 Parameter for analog outputs
in road and rail tunnel
applications and crane
applications. The parameter
provides horizontal and
direction data.

autoPort 1 1 = COM1 port

2 = COM2 port

 Serial port to which WMT700
sends automatic data
messages.

autoSend 0 0 = Automatic
messages
disabled 1 … 99

 Automatic data message
number. Selects the data
message format for automatic
messages.

cal_date    Wind calibration date. This is a
read-only parameter.

com1_baudcom2_baud 4 0 = 300

1 = 1200

2 = 2400

3 = 4800

4 = 9600

5 = 19200

6 = 38400

7 = 57600

8 = 115200

 Baud rates for serial ports
COM1 and COM2. Changes
take effect only after reset or
the RESET command. Note
that a low bit rate can affect
measurement timing, if
WMT700 cannot send the
data message before a new
measurement starts.

com1_data com2_data 8 7 = 7 data bits

8 = 8 data bits

 Data bits for serial ports COM1
and COM2. Changes take
effect only after reset or the
RESET command.

com1_delaycom2_delay 20 0 … 10000 ms COM1 and COM2 Response
delay in milliseconds.
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Parameter Name Default
Value

Allowed Values Units Description

com2_interf 0 0 = RS-485

1 = RS-422

2 = SDI-12

3 = RS-232

 Interface for serial port COM2.
(The interface for serial port
COM1 cannot be changed.)

com1_paritycom2_parity 0 0 = None

1 = Even

2 = Odd

 Parity for serial ports COM1
and COM2.Changes take effect
only after reset or the RESET
command.

com1_protocol 0 0 … 11  Protocol for serial port COM1.

• 0 = WMT700
• 2 = WS425 F/G ASOS
• 3 = WS425 A/B ASCII
• 4 = WS425 A/B NMEA

Standard
• 5 = WS425 A/B NMEA

Extended
• 6 = WS425 A/B WAT11
• 8 = MES12
• 11 = WMT700 NMEA MWV

com2_protocol 0 0 … 11  Protocol for serial port COM2.

• 1 = SDI-12
• 2 = WS425 F/G ASOS
• 3 = WS425 A/B ASCII
• 4 = WS425 A/B NMEA

Standard
• 5 = WS425 A/B NMEA

Extended
• 6 = WS425 A/B WAT11
• 8 = MES 12
• 11 = WMT700 NMEA MWV

com1_stopcom2_stop 1 1 = 1 bit

2 = 2 bits

 Stop bits for serial ports COM1
and COM2. Changes take
effect only after reset or the
RESET command.

freqType 0 0 = Push-pull

1 = Active pull-
down

2 = Active pull-
up

 AOUT1 frequency output type.
Setting 1 requires external pull-
up resistor. Setting 2 requires
external pull-down resistor.

heaBMaxPower 150 0 = Off

150 = On

W heaBMaxPower sets
maximum body heater power.
Setting the parameter value to
0 disables WMT700 body
heating.
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Parameter Name Default
Value

Allowed Values Units Description

heaPeakPwr 200 min ... max = 0 ...
200 W

 heaPeakPwr determines how
many resistors are on at the
same time. WMT700 has three
heater resistors for each arm.
heaPeakPwr does not limit
the power in the body heater
of a heated version.

heaterOn 1 0 = Heater off

1 = Automatic

 Heater control. When the
value is set to 1, WMT700
controls the heaters based on
the temperature and other
conditions.

messages 1 0 = Disabled

1 = Enabled

 Response for parameter
setting.

msg1, msg2, msg3, msg4  String with a
maximum of 80
characters.

 User-configurable data
message formats. Parameters
correspond to the message
identification numbers from 1
to 4.

serial_n    Serial number for WMT700.
This is a read-only parameter

serial_pcb    Circuit board serial number.
This is a read-only parameter.

sleepTime 5 0 = Disabled 1 …
32000

s Duration of the low-power
mode in seconds. WMT700
returns automatically to
normal state after this period
of time has elapsed. You can
also return to normal state by
sending an extra space before
the polling command.

startDelay 5 0 … 30 s Defines how long WMT700
waits before activating
automatic messages at
startup.

wndAvg 1 0.25 … 3600
Resolution: 0.25

s Averaging time for wind
measurement in seconds. This
parameter affects both serial
communication and analog
output.

wndCoast 0 0 … 100 0 =
Disabled

m/s Wind direction coasting
threshold in meters per
second. When wind speed
drops below the limit, wind
direction coasting is
performed. Only affects the
scalar averaging mode.
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Parameter Name Default
Value

Allowed Values Units Description

wndCover 4 0 ... 20 seconds s Defines how long WMT700
continues to report the last
valid wind value if wind
measurement fails (for
example due to snow or birds).
0 means that if measurement
fails, WMT700 reports missing
measurement data
immediately.

wndDirOffset 0 -180 … 180
degrees

Deg User-defined wind direction
offset.

wndGainLo 1  % Wind tunnel tests show that
the bird cage systematically
lowers the wind speed reading
by 1.5 % (cage) or 2.5 % (cage
and net). The wndGainLo
parameter can be used to
compensate for wind speed
gain correction for the bird
cage.

S wndGainLo,1.015

wndGustTime 3 0.25 … 10
Resolution: 0.25

s Averaging time for wind
minimum and maximum in
seconds.

wndOrientation 0 0 = Array facing
up

1 = Array facing
down

 Orientation of the transducer
arms of WMT700.

wndRate 1 1 = 4 Hz

2 = 8 Hz

Hz Wind vector update rate. For
best performance in wind
speeds over 50 m/s, Vaisala
recommends the 4 Hz rate.

wndUnit 0 0 = m/s

1 = mph

2 = km/h

3 = knots

 Wind speed unit. This
parameter affects data
messages sent through serial
interfaces but has no impact
on analog output.

wndVector 0 0 = Scalar
averaging

1 = Vector
averaging

 Wind averaging method
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Appendix E. WMT700 NMEA
MWV Profile

E.1 Configurable Parameters
When the WMT700 NMEA MWV profile is selected, you can set WMT700 to send messages
based on the configured automatic message interval or poll MWV message using the NMEA
Query command.

The following table shows the configurable parameters and their allowed and default values
for the WMT700 NMEA MWV profile.

Table 74 Configurable Parameters for WMT700 NMEA MWV Profile

Parameter Default
Value

Profile-Specific Allowed
Values

Description

address N/A String with 2 characters, for
example WI

Address for WMT700. The address must
consist of two capital letters A … Z

autoInt 1 0.25 ... 1000 Resolution:
0.25

Automatic message interval in seconds. Do
not select a message interval that is
shorter than the time it takes to send a
data message

autoPort 1 1 = COM1 port

2 = COM2 port

Serial port to which WMT700 sends
automatic data messages

autoSend 0 0 = Automatic messages
disabled

20 = WMT700 NMEA MWV
automatic data message

Automatic data message number. Selects
the data message format for automatic
messages

com1_protocol 0 11 = WMT700 NMEA MWV
protocol

Profile for serial port COM1

com2_protocol 0 11 = WMT700 NMEA MWV
protocol

Profile for serial port COM2

com2_interf N/A 0 = RS-485

1 = RS-422

3 = RS-232

Interface for serial port COM2

wndAvg 1 0.25 … 3600 Resolution:
0.25

Averaging time for wind measurement in
seconds

wndOrientation 0 0 = Array facing up

1 = Array facing down

Orientation of the array of WMT700
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Parameter Default
Value

Profile-Specific Allowed
Values

Description

wndUnit 0 1) 0 = Meters per second

1 = Miles per hour

2 = Kilometers per hour

3 = Knots

Wind speed unit

wndVector 0 0 = Scalar averaging Wind averaging method

1) COM1 service port is always by default 0 - WMT700 protocol. You can change this using serial commands if COM1 is needed
for protocol-specific communication.1)

2) Wind speed unit and COM2 digital communication interface are defined in the order form. Default setting may be any of the
allowed options , and it can be verified from the unit's configuration code.2)

To start continuous measurement, use the START command. You can stop the measurement
with the STOP command.

E.2 WMT700 NMEA MWV Commands
This command polls data from WMT700 when the WMT700 NMEA MWV protocol is
selected.

$--<id>Q,MWV*<chk><CR><LF>

$ Message header

-- Two-character talker ID of the polling unit

<id> Two -character WMT700 sensor ID; AA … ZZ

Q Query command

, Field delimiter

MWV Sentence formatter

*<chk> Checksum field(8-bit XOR, excluding $ and *)

<CR> Carriage return code, ASCII 0DH

<LF> Line feed code, ASCII 0AH

To use WMT700 with the WMT700 NMEA MWV profile, either set the autoSend
parameter to 0 to enable polling or define a fixed output interval with the autoInt
parameter. If you are using automatic messages, the value for the autoSend parameter
must be set to 20.
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E.3 WMT700 NMEA MWV Data Message
WMT700 NMEA MWV data message is as follows:

$<id>MWV,<dir>,<ref>,<spd>,<uni>,<sta>*<chk><CR><LF>

$ Message header

<id> Two character sensor ID; AA … ZZ

MWV Fixed text

<dir> Wind angle: 0 to 359 degrees

<ref> Reference: R = Relative

<spd> Wind speed

<uni> Wind speed unit: K = Kilometers per hour M = Meters per second N = Knots

<sta> Status: A = Valid data V = Invalid data

* Fixed text

<chk> Checksum (8-bit XOR, excluding $ and *)

<CR> Carriage return code, ASCII 0DH

<LF> Line feed code, ASCII 0AH

Example of the command and response:

$IIWIQ,MWV*2F<CR><LF>
$WIMWV,045,R,011.63,N,A*09<CR><LF>

Interpretation of the example message:

• Talker ID "II" queries the WMT700 NMEA MWV message from sensor which has address
parameter set to "WI".

• WMT700 responds with talker ID "WI" and the requested MWV message. The reported
relative wind direction is 045 degrees and the wind speed is 11.63 knots.

Missing Readings

If data is missing due to a measurement problem, the NMEA messages show "V" in the
status field. Wind speed and wind direction fields are left empty.

E.3.1 Missing Readings
If data is missing due to a measurement problem, the NMEA messages show V in the status
field. Wind speed and wind direction fields are left empty.
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Appendix F. WMT700
Accessories

Figure 53 Complete Set of WMT700 Accessories
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1 Bird perch (WMT70BirdPerch)
2 Bird cage (WMT70BirdKit)
3 Zero wind verifier (WMT70Verifier)
4 Vaisala WMT700
5 Adapter for WMT70FIX, WMT700FIX-POM, and WMT700FIX60-RST (228869)
6 Adapter for WS425FIX30, WS425FIX60, and WAC425 (228777)
7 Plastic mounting adapter for 60 mm tube (WS425FIX60-POM)
8 Mounting adapter for 30 mm tube (WS425FIX30)
9 Sensor support arm for 60 mm mast (WAC425)
10 ASOS mounting adapter (ASM212149)
11 Stainless steel mounting adapter for 60 mm tube

(WS425FIX60-RST).
12 Aluminum mounting adapter for 60 mm tube (WS425FIX60)
13 Plastic mounting adapter for 60 mm tube (WMT700FIX60-POM)
14 Stainless steel mounting adapter for 60 mm tube ( WMT700FIX60-RST)
15 General purpose mounting adapter for WMT700 (WMT70FIX)
16 Cross arm (WMT70CrossArm)
17 Cable tightening tool (237888SP)
18 Cables with open lead (227267SP, 227568SP, 228259SP, 237889SP, 237890SP)
19 Vaisala MAWS cable (227565SP)
20 Vaisala AWS cables (229807SP, 227566SP)
21 Vaisala WS425 adapter cables (227569SP, 227570SP, 227571SP)
22 WMT700 connector DIY kit (WMT70Conn)
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Appendix G. Certificate
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averaging time........................................................ 149

B
backup battery....................................................... 183
bird cage..............................................................27, 70
bird net................................................................ 71, 197
bird perch..................................................................197
body heating parameter.......................................82

C
cables............................................ 28, 72, 73, 80, 197

ROSA Cable 10 m................................................93
RS-485..............................................................74, 75
WMT700.................................................................93
WS425.....................................................................94

cable tightening tool..............................29, 54, 197
calibrating...................................................................27
calibration data...................................................... 109
certificate..................................................................199
changing

communication profile.....................................133
changing address...................................................155
changing settings....................................................99
COM1............................................................40, 73, 183
COM2....................................................40, 73, 74, 183
commands
?............................................................................... 108
?!............................................................................. 154
a!............................................................................. 155

aAb!........................................................................ 155
aC!................................................................... 156, 161
aCC!......................................................................... 161
aD0!............................................................... 157, 160
aI!........................................................................... 157
aM!...........................................................................158
aMC!......................................................................... 161
aV!...........................................................................159
BAUD........................................................................ 105
CLEARERR.............................................................. 107
CLOSE............................................................. 100, 101
ERRORS.......................................................... 106, 169
G............................................................................... 104
H............................................................................... 108
I................................................................................148
M 12........................................................................ 128
MEAS............................................................... 106, 126
OPEN...............................................................100, 126
POLL........................................................ 38, 107, 127
RESET......................................................................108
S............................................................................... 103
SLEEP...................................................................... 127
START..................................................................... 106
STOP........................................................................ 106
VERSION.................................................................108
WA..............................................................................137
WD............................................................................. 139
WF.............................................................................140
WIN_GET.................................................................109
WS..............................................................................137
WT............................................................................. 138
Wx............................................................................. 149

command set............................................................ 181
communication interface..............................39, 40
communication profiles.......................................133

default settings...................................................185
compass safe distance........................................... 51
compliances................................................................17
configurable parameters.....................................193
configuration............................................................ 101

example...................................................................26
files........................................................................... 115
parameters...........................................................109

configuration mode..............................................100
connecting cables...................................................54
connection cables............................................24, 92
connector DIY kit................................................... 197
connector pins

M23........................................................................... 75
WMT700.................................................................97
WS425.....................................................................97

Index

201



continuous measurement.....................................38
crane application.....................................................68
crane installation..................................................... 65
cross arm........................................................... 60, 197
current consumption..............................................77
cyclic redundancy...................................................161

D
data messages.................................................119–124

configurable........................................................ 109
items........................................................................ 110
WMT700 NMEA MWV.....................................195
WS425 A/B NMEA Extended.......................146
WS425 A/B NMEA Standard........................ 143
WS425 F/G ASOS............................................. 140

deviation angle.........................................................65
diagnostics...............................................................106
digital communication interface....................... 20
digital communication profile............................. 21
digital communication units.................................21
disabling body heating......................................... 82
display help..............................................................108

E
electrical specifications....................................... 174
entering configuration mode........................... 100
errors.........................................48, 124, 132, 167, 169
exiting configuration mode.......................100, 101
external interfaces...................................................38

F
fetching data...................................................107, 157
fetching diagnostics..............................................137
FIX30 / FIX60 / FIX70.....................................11, 86
frequency.................................................................. 129
frequency output.................................................... 43
fully heated sensor................................................. 50

G
get message............................................................ 107
get parameter......................................................... 104

H
handling.......................................................................52
heated transducers.................................................49
heating......................................................... 20, 49, 50
heating options........................................................48
heating power supply............................................ 79

I
information commands....................................... 108
installation

crane........................................................................ 65
maritime...................................................................51

retrofit.......................................................82, 83, 97
tunnel............................................................... 65, 66

installing
bird cage................................................................ 70
WMT700..................................................................51

J
junction box...............................................................28

L
location.........................................................................51

M
M23 connector...................................................72, 75
maintenance............................................................ 163
manual......................................................................... 25
mA output.......................................................... 66, 68
maximum peak power............................................81
Measnet........................................................................ 19
measurement methods......................................... 38
measurement mode.................................... 100, 126
measurement mode commands...................... 125
measurement path...................................................31
measurement principle...........................................31
measurement problem.........................................124
measurement range................................................ 19
MES12................................................................. 124, 128
missing reading............................. 48, 124, 132, 195
modes

automatic message.................................... 38, 119
configuration...................... 41, 100, 101, 126, 135
low-power............................................................. 127
measurement.......................................41, 100, 125
poll............................................................................ 38

mounting
ASOS mounting kit............................................ 90
cross arm............................................................... 60
vertical pole mast................................................57
WS425 mounting kit..........................................83

mounting adapter
30 mm tube......................................................... 197
60 mm tube......................................................... 197
general purpose................................................. 197

mounting adapters................................................. 24
mounting kit

ASOS adapter...................................................... 90
FIX30....................................................................... 83
FIX60....................................................................... 83
WS425............................................................. 83, 88

mounting kits.......................................................11, 86

N
North arm.............................................................. 11, 63
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O
operating power.......................................................77
operating principle...................................................31
operating WMT

WS425 analog output mode.........................128
operating WMT700............................... 117, 118, 134

SDI-12 profile....................................................... 133
WS425 profile..................................................... 133

orange sticker, see North arm
ordering options....................................................... 18
output signals...................................................47, 132
output specifications............................................ 174

P
parameter descriptions....................................... 187
parameters............................................................... 102

configuration....................................................... 187
WS425 NMEA Extended Profile.................. 144

parameter value..................................................... 104
peak power................................................................. 81
poll data..................................................................... 127
poll mode....................................................................38
port settings................................................... 105, 170
power consumption................................................77
powering......................................................76, 80, 97
power supply............................................................ 38
problems.......................................... 48, 132, 167, 169
profiles

F/G ASOS..............................................................135
MES12...................................................................... 40
ROSA.......................................................................40
ROSA MES12........................................................ 128
WMT700....................................................... 40, 125
WS425 A/B ASCII..............................................147
WS425 A/B NMEA Standard........................ 142
WS425 A/B WAT11............................................150
WS425 ASCII........................................................40
WS425 ASOS....................................................... 40
WS425 NMEA Extended..................................40
WS425 NMEA Extended Profile.................. 144

protocols
MES12........................................................................41
NMEA MWV............................................................41
SDI-12........................................................................ 41
WS425 ASCII......................................................... 41
WS425 ASOS.........................................................41
WS425 NMEA........................................................41
WS425 WAT11........................................................41

R
resetting CPU.......................................................... 108
resetting error counters...................................... 107
restoring settings...................................................170

RS-232..........................................................................73
see communication interface

RS-422......................................................................... 73
see communication interface

RS-485......................................................................... 73
see communication interface

S
scalar averaging.......................................................36
SDI-12....................................................................40, 73

commands............................................................ 153
see also communication interface
configurable parameters................................. 151
data messages................................................... 160
profile...................................................................... 151

send identification................................................. 157
sensor parts................................................................. 11
sensor power..............................................................81
serial communication............................................ 40
serial connection.....................................99, 118, 134

analog output ......................................................39
serial interface timing............................................42
serial output.............................................................. 95
serial port.........................................................105, 170

settings..................................................................105
setting parameter values...........................103, 109
show port settings................................................ 105
show version............................................................108
standards..................................................................... 17
starting measurement...............106, 149, 156, 158
starting verification...............................................159
starting wind measurement.............................. 106
status flags................................................................ 113
stopping measurement....................................... 106
support commands.............................................. 106

T
technical data ......................................................... 174
temperature range................................................... 19
terminal program....................................99, 118, 134
testing operation................................................... 164
trademarks..................................................................10
transportation damper.......................................... 52
tunnel installation....................................................65

U
unpacking...................................................................52
upgrading WS425.................................... 82, 86, 88

V
vector averaging...................................................... 37
verifier........................................................................ 164
voltage................................................................77, 130
voltage output......................................................... 131
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W
wind direction.................................. 34, 35, 137, 173
wind direction averaging......................................36
wind direction coasting.........................................37
wind direction offset...................................... 63, 65
wind direction output............................................131
wind measurement commands........................106
wind measurement on request.......................... 38
wind speed........................................ 34, 35, 137, 173
wind speed average..............................................120
wind speed output................................................ 129
wiring............................................................................72

COM2 RS-485....................................................... 74
heated WMT700..................................................77
non-heated WMT700........................................ 77
retrofit installation.............................................. 93

WMT700 commands............................................. 181
WMT700 NMEA MWV commands................. 194
WMT700 profile commands..............................125
WS425 A/B ASCII commands.......................... 148
WS425 A/B NMEA extended commands.... 145
WS425 A/B SDI-12........................................ 160, 161
WS425 A/B WAT11

commands............................................................. 151
WS425 cable.............................................................131
WS425 F/G ASOS commands........ 136, 138–140

Z
zero alignment..........................................................65
zero wind verifier............................................ 27, 197
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Warranty
For standard warranty terms and conditions, see www.vaisala.com/warranty.

Please observe that any such warranty may not be valid in case of damage due to normal
wear and tear, exceptional operating conditions, negligent handling or installation, or
unauthorized modifications. Please see the applicable supply contract or Conditions of Sale
for details of the warranty for each product.

Technical Support

Contact Vaisala technical support at helpdesk@vaisala.com. Provide at least the following
supporting information:

• Product name, model, and serial number
• Name and location of the installation site
• Name and contact information of a technical person who can provide further

information on the problem

For more information, see www.vaisala.com/support.

Recycling

Recycle all applicable material.

Follow the statutory regulations for disposing of the product and packaging.
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